More information about DxO PhotoLab can be found at www.dxo.com

**Trademarks**

DxO is a registered trademark of DxO Labs both in the European Union and in other countries. Microsoft, Windows, Windows Vista, Windows 7 and Windows 8 are registered trademarks of Microsoft Corporation. Mac OS X and the Mac logo are trademarks of Apple, Inc., registered in the United States and in other countries. FLICKR and the Flickr logo are trademarks of Yahoo! Inc. The Flickr logo ©2012 Yahoo! Inc.) is reproduced with the permission of Yahoo! Inc. Facebook is a registered trademark of Facebook, Inc. All other trademarks are the property of their respective owners.

**Patents**

DxO Labs holds patents that protect DxO software products; a list of these patents can be consulted at www.dxo.com/intl/patents.

**Acknowledgments**

DxO PhotoLab may utilize the following copyrighted material, the use of which is hereby acknowledged:

- DirectoryInfoEx (Licence LGPL v3) : http://www.codeproject.com/Articles/39224/Rewrite-DirectoryInfo-using-IShellFolder
- DotNetZipLib (Ms-PL) : http://dotnetzip.codeplex.com/license
- Lualnterface (MIT License) : http://code.google.com/p/lualnterface/
- MVVMLightToolkit (MIT License) : http://mvvmlight.codeplex.com/license
- NLog (BSD License) : http://nlog-project.org/
- PowerCollections (Eclipse public license) : http://powercollections.codeplex.com/license
- SQLite (Public Domain) : http://www.sqlite.org/copyright.html
- Flickr.Net (LGPL) : http://flickrnet.codeplex.com/license
- Facebook SDK for .Net (Apache 2.0) : http://facebooksdk.net/docs/about/

The information contained in this guide is provided “as is”. In no case, including negligence, can DxO Labs be held responsible for any damage, be it specific, direct, indirect, or consecutive, which may result from or be tied to the use of any information contained in this guide, with or without the software described in this document.

v1.0
# Table of Contents

Introduction to DxO PhotoLab ................................................................. 1
  DxO optics modules ......................................................................... 4
  General interface ........................................................................... 6
  Viewing your images .................................................................. 12
  Managing your files .................................................................. 17
  Finding your images .................................................................. 21
  Filtering & Selecting the best images ......................................... 26
  Roughing .................................................................................. 31
  Apply Presets ........................................................................... 34
  Basic Editing ............................................................................ 41
  Tone & Color advanced adjustments ......................................... 52
  Noise reduction & Sharpening .................................................... 55
  Local adjustments & Details corrections ................................... 59
  Fine tune Lens corrections & Geometry ...................................... 75
  Advanced image effects .............................................................. 83

Support for DxO ONE ...................................................................... 88

Exporting images .......................................................................... 90
  About the Export feature .......................................................... 91
  Interface ................................................................................... 92
  Export to disk .......................................................................... 93
  Export to application ............................................................... 96
  Workflow with Lightroom ......................................................... 97
  Export to Facebook ................................................................ 99
  Export to Flickr ....................................................................... 100
  Printing - Microsoft Windows ................................................... 102
  Printing - OS X ...................................................................... 105
  Menus and preferences - Microsoft Windows ......................... 107
  Menus and preferences - OS X .................................................. 113
  Keyboard shortcuts ................................................................. 118
  Registration, downloading, installation and activation .......... 121
  System requirements ............................................................... 123
  Supported file formats ............................................................. 124
Introduction to DxO PhotoLab

Welcome to DxO PhotoLab, whose powerful tools will help you enhance your photos quickly and automatically.

We have tested your camera and lenses

First let us introduce our company: DxO is a high-technology firm that specializes in digital image processing. Our engineers publish papers in the most prestigious journals in the world. Thanks to this scientific and particularly mathematical foundation, we have been able to design DxO PhotoLab as a tool that aims not just to improve quality, but to achieve perfection — and more specifically, automatic perfection.

What makes DxO PhotoLab so special is that we test in our laboratories all of the equipment that you use. Each camera and lens spends several days in the hands of our technicians, who measure not only optical defects such as distortion, vignetting, and lens softness, but also the noise, colorimetry, and tone curves for each piece of equipment. They even analyze any in-camera processing that is applied to the images.

The result is a huge database that has no equivalent anywhere else in the world — the first pillar on which our exclusive quality is based. It is this database that gives DxO PhotoLab the information it needs about the camera and lens used to shoot a given image, along with the aperture, focal length, exposure time, etc. — to be able to calculate all of the necessary corrections: that this pixel needs to be brightened by x%; that that pixel needs to be moved by a particular distance in a particular direction; that yet another pixel needs its red channel adjusted, and so on. But all of these corrections require no effort on your part: the software downloads the profiles of your camera and lens all by itself, and then applies the necessary changes automatically.

Our software analyzes each of your images individually

Each photograph is unique — even photographs of the same subject under similar shooting conditions will differ from one another. One may contain a slightly overexposed area. The other might be too grainy because of noise in deep shadow. Yet a third photo might lack a bit of contrast. How can one handle all of these differences?
For most photo software developers, the answer is simple: they will provide you with a number of correction tools and then leave you to fix each of your photos one at a time. But this is not how DxO PhotoLab works. To our way of thinking, it is DxO PhotoLab’s job to analyze each image and to determine if any corrections are necessary—and if so, to apply optimized corrections. After doing all this, the software submits the resulting images to you to judge — and to adjust any of the applied corrections according to your own taste and judgment.
**What DxO PhotoLab does to your images**

- If your original photo is in RAW format, DxO PhotoLab provides it with the best RAW converter ever designed. When transforming the RAW sensor data using the "demosaicing" process (which converts raw data from the sensor into red, green, and blue pixels), among other processes, DxO’s converter creates an image that is virtually free of artifacts.

- Without any user intervention required, DxO PhotoLab corrects four optical defects: distortion, vignetting, lateral and longitudinal chromatic aberrations, and lens softness. To do so, it makes use of a unique database in which years of test data from our laboratories about the optical defects of lenses and cameras is stored.

- DxO PhotoLab subtly and automatically retains highlights in RAW images while preventing them from being clipped, and even recovers certain details in areas that are already clipped. (We advise you to work in RAW whenever possible to take advantage of the greater latitude in processing and correcting your images.)

- Thanks to our laboratory measurements of each camera body, DxO PhotoLab includes unrivaled denoising tools that let you obtain high-quality images at the highest sensitivities.

- DxO PhotoLab offers a unique automatic correction of contrast and lighting in shadows, equivalent to a fill-in flash, for radically improving any high-contrast or backlight photos.

- DxO PhotoLab provides efficient tools for modifying an image’s color rendering such that you can make it seem like your image was taken with a different camera, or taken using analog film.

- Finally and most importantly, the software performs nearly all of the corrections mentioned above automatically, while leaving you the ability to fine-tune or adapt the results to suit your taste.

**About DxO FilmPack plug-in for DxO PhotoLab**

DxO FilmPack brings to digital photos all of the quality and emotion of Fine Arts photography by associating precisely-simulated analog film renderings with high-quality original renderings and creative effects. Based on DxO Labs’ advanced calibration technologies, DxO FilmPack faithfully restores the characteristic colors, contrast, saturation, and grain of dozens of legendary films.

DxO FilmPack for Microsoft Windows and OS X comes in two editions, ESSENTIAL and ELITE, which differ in terms of the number of film renderings and features available. DxO PhotoLab contains a trial version of DxO FilmPack, which can be launched via the Help menu (Windows) or the DxO PhotoLab menu (Mac). The free trial lasts for 31 days.

As a plug-in for DxO PhotoLab, DxO FilmPack is completely integrated and appears as a dedicated palette in the Customize tab to give you the best and most comfortable user experience — letting you treat an entire batch of images as part of a totally-reversible RAW workflow.

**About DxO ViewPoint plug-in for DxO PhotoLab**

DxO ViewPoint fixes even the most complex perspective problems, and easily restores the natural shapes of subjects situated on the edges of images.

As a plugin, DxO ViewPoint integrates perfectly with DxO PhotoLab: all is features are easily accessible in a new dedicated palette. DxO ViewPoint can also be used as a standalone application and as a plugin for Adobe Photoshop, Photoshop Elements, Adobe Lightroom.
DxO Optics Modules

DxO PhotoLab provides automatic installation of the DxO Optics Modules that correspond to the equipment that you use. Two dialogue windows help you manage your DxO Optics Modules.

You must have an active Internet connection to look for and install DxO Optics Modules while using DxO PhotoLab. You can also manually download Optics Modules from this webpage.

Installing new DxO Optics Modules

To install DxO Optics Modules, go to DxO Optics Modules > Download new DxO Optics Modules (Microsoft Windows) or DxO Optics Modules > Manage DxO Optics Modules (OS X).

The DxO Optics Module installer or manage window offers you a list of cameras arranged by brand in alphabetical order. Under Microsoft Windows, you can display the complete list, or you can select a particular manufacturer from the Brand drop-down menu.

To download additional DxO Optics Modules, proceed as follows:

Microsoft Windows

1. Use the corresponding checkboxes to select one or more camera models.
2. Click on Next.
3. Use the corresponding checkboxes to select one or more lens models (the availability status of the relevant Optics Modules will be clearly indicated).
4. Click on Next.
5. The window will display a summary of the DxO Optics Module(s) for the camera/lens combination(s) you have chosen.
6. Click on Next.
7. The selected Optics Module(s) is/are downloaded and installed.
8. A dialogue box confirms the installation.
9. Click on OK to close the Optics Modules installer.

OS X

1. Click on the arrow to the left of a manufacturer’s name to select the brand, then click on the arrow to the right of the appropriate camera model.
2. Select a camera - lens combination from the list by clicking on Download.
3. The corresponding Optics Module is downloaded and automatically installed.
4. Repeat the same steps to install another Optics Module.
5. Click on Close to return to the main DxO PhotoLab interface.

Managing DxO Optics Modules

Microsoft Windows

The DxO Optics Modules window displays all of the Optics Modules installed on your computer. To display this window, go to the DxO Optics Modules > Installed DxO Optics Modules menu. You can also filter the list so as to see only those models that need to be updated or which are not yet supported.

![DxO Optics Modules window]

To download an Optics Module again, select it in the list and then click on Download in order to open the Install new modules window.

You can delete an Optics Module in the same manner by clicking on Remove. A dialogue box will prompt ask you to confirm that you want to delete the Optics Module.

OS X

The Manage DxO Optics Modules window lets you display all of the DxO Optics Modules installed on your computer when you check the Show only installed DxO Optics Modules box in the lower left corner.

To install additional DxO Optics Modules, uncheck the Show only installed DxO Optics Modules box, and follow the steps in section above (OS X).

To delete a DxO Optics Module from your computer, find it in the list and click on the corresponding Remove button.

A DxO Optics Module used during an ongoing work session cannot be uninstalled. In order to do so, you will need to restart DxO PhotoLab and go to the Manage DxO Optics Modules window before you load any images.
Workspace

- The Organize tab
- The Customize tab
- Essential tools
- Managing palettes and workspace

The Organize tab

On launch, DxO PhotoLab opens in the Organize tab. This first step lets you find and select the folder or project containing the images that you would like to process (either singly or as a batch).

The Organize tab is composed of four principal sections or panes:

1. The **Command bar** lets you navigate through your file system, display your images, and apply presets.
2. The **Source browser** lets you navigate through folders or projects to locate the photos you want to work on.
3. The **Image Browser** displays, as thumbnails, the pictures in a selected folder or project.
4. The **Viewer** shows the selected image in the Image Browser.

You can adjust the sizes of these four panes to suit your needs. They are delimited by two separator bars, one horizontal and one vertical, both indicated by central dots, or by a Microsoft Windows arrow, or by a OS X dot. Each bar can be moved at will, changing the relative size of each part of the screen.
The Customize tab

The Customize tab is the second key component of the DxO PhotoLab user interface. It groups together all of the image analysis and correction tools.

The Customize tab is divided into four parts:

1. The **command bar**, similar to that for the Organize tab, lets you control how your images will be displayed, and contains a number of other tools that we will describe below.

2. The **palettes** contain all the correction tools. You can detach and move the palettes around as you wish (see sections 3.3.1 and 3.3.4 below).

3. The **viewer** is the central window in the application, and displays one image at a time (which you select in the Image Browser). It allows you to see the effects of the corrections you make with the various tools. You can also display both the original and the corrected images either one on top of the other, or side-by-side.

4. The **image browser**, available in both tabs, displays the contents of a folder or project as thumbnails.

**Essential tools**
The Essential Tools palette contains the principal tools required for processing your images, and includes tools for correcting:

- White balance
- Exposure compensation
- DxO Smart Lighting (Uniform mode and Spot Weighted mode).
- Selective tone
- DxO ClearView (ELITE Edition)
- Contrast
- Color accentuation
- Noise reduction
- Horizon
- Crop

These tools are accessible in dedicated palettes (described later on in this guide).
Managing palettes and workspace

About the workspace

When you open DxO PhotoLab, all of the correction palettes appear in the right-hand column, but only the new Essential Tools palette is expanded, along with a limited number of its component palettes. These tools let you perform the most important corrections. Of course, you have full access to all available palettes; all you need to do is expand them by clicking on their title bars to access all of their tools.

Certain parts of workspaces cannot be modified, such as the command bar and the viewer. However, you can change the arrangement of the palettes and how the tools are grouped. You can not only decide what palettes should be displayed or hidden, but you can detach them and place them anywhere on your screen. You can create, save, change, and delete any custom workspace (ELITE Edition).

Using and moving palettes

Palettes are containers that group together tools that have a particular purpose in common. For example, the Essential Tools palette includes tools for correcting white balance, exposure, contrast, etc. — which are all required for basic image enhancement.

You can hide or display a palette either by clicking on its title bar (Microsoft Windows only) or on the arrow on the left side of the title bar (both platforms).

By default, correction palettes are anchored in the right-hand column, and the image analysis, EXIF, and presets palettes are anchored on the left. Any palette can be detached and placed anywhere on the screen. To detach a palette, simply drag it by its title bar to the desired location. To close a palette (that is, to no longer have it displayed in the workspace), click on the X in its title bar.

The correction palettes
All of these operations can also be performed by using the drop-down menu that is found in the title bar of each palette. This menu lets you open and close the palette; anchor it in the left- or right-hand column; move it to wherever you want on your screen; and also change its order in the column where it is anchored.

It is also possible to anchor all the palettes in one single column to the left or the right of the image in order to provide more space to display the image.

To have even more space to work on your image, you can temporarily hide all of the palettes. For Microsoft Windows, go to the Palettes > Hide/Display all palettes menu, or press the F9 function key (Microsoft Windows), or press the Tab key (OS X).

Your workspace

When you use DxO PhotoLab for the first time, the workspace displays the following palettes and sub-palettes:

- **Histogram**: Displays the light divisions for each of the RGB and Luminance channels.
- **Essential Tools** include the basic correction tools: White Balance, Exposure compensation, DxO Smart Lighting, Selective tone, DxO ClearView, Contrast, Color accentuation, Noise reduction, Horizon, and Crop.
- The advanced settings palettes are closed by default: Light, Color, Detail, Geometry.

Create a custom palette (ELITE Edition)

It is very easy to create your own custom palette. Just follow these steps:

**Microsoft Windows**
1. Open the menu **Palettes > Create user palette**.
2. Enter a name in the **My palette** floating window.
3. After you click on **OK**, your new palette will appear on the right, underneath the other palettes.
4. At this point your new palette is empty, but you will see a message prompting you to drag and drop your favorite correction tools into it.
5. As soon as you have finished populating the new palette with the tools you want to use for your corrections, you can close all of the other palettes.

**OS X**
1. Open the menu **View > Palettes > New palette**.
2. Enter a name in the New palette floating window.
3. After you click on **OK**, your new palette will appear as a floating window in the application window.
4. To add palettes and their associated tools, click on the icon at the extreme right in the title bar of your new palette and then select each tool you want to use from the list one at a time.
5. As soon as you have finished, you can anchor the palette in either the left or the right column in whatever order your wish.

Creating a custom workspace

You can create your own custom workspace(s) in DxO PhotoLab, in which you can add standard as well as your custom palettes as desired. To create a workspace:
1. Click on the **X** on the left in the title bar of the palettes that you do not want to use in your new workspace.
2. If needed, follow the procedure in the preceding section for creating new palettes.
3. To save your new workspace, open the Workspace menu and then select **Save Workspace**.
4. Enter a name for your custom workspace in the Save Workspace floating window.

5. Click on Save.

Your custom workspace will be available:

- In the Workspaces menu (Microsoft Windows).
- In the View > Workspaces menu (OS X).

⚠️ When you quit from DxO PhotoLab, the last workspace you have selected will be the workspace displayed upon relaunching.

To delete a custom workspace:

- Select the workspace you want to delete in the Workspaces menu, and then select Delete Workspace. A dialog box will prompt you to confirm your decision (Microsoft Windows).
- Select the workspace you want to delete and then choose Delete Workspace from the menu View > Workspaces. A dialog box will prompt you to confirm your decision (OS X).

⚠️ You cannot delete the DxO Standard workspace.
Viewing your photos

- Full screen mode
- The command bar
- Exif

Full-screen mode (Viewer)

Full-screen mode lets you display the image by itself, without any UI elements, so you can easily compare a reference image with another (before correction, virtual copy, etc.), and rate or assign selection markers to your photos.

You can activate full-screen mode by:
- Clicking on the corresponding full-screen button in the command bar.
- Selecting Full-screen (Viewer) in the Display menu.
- Using the keyboard shortcut F12 (Microsoft Windows) or Cmd+Maj+F (OS X).

Full-screen mode is accessible in both the Organize and the Customize tabs.
Displaying images

- **To navigate from one image to another**, use the left and right arrow keys on your keyboard.
- **To delete an image**, press the Delete key (Microsoft Windows) or Cmd+Delete (OS X).
- **To fit the image to the screen**, use the F3 key (Microsoft Windows) or Cmd+0 (OS X).
- **To display the image at 100%**, press F4 (Windows) or Cmd+1 (OS X).
- **To change from Fit-to-screen to 100%, or the reverse, double-click in the image.**

In Windows, full-screen mode is equipped with a navigation loupe for when you are zoomed in on the image. To activate or deactivate it, click on the button on the bottom right, and then click on Navigation. As soon as you zoom in on the image, you can navigate within it by placing the tile in the loupe window.

Assigning selection markers and ratings

If you click on the central button (with a chevron on it), you will display the toolbar with the file name and type, and an image selection and rating bar. To hide these, click on the same button.

- **To assign a selection marker**, click on the icons located under the image: the green “Tag” dot is on the left; the red “untag” dot is on the right. Simply click on the colored dot again to get rid of the selection marker.

You can also use these keys on your keyboard to assign selection markers: 7 (Save), 8 (no marker, unassign marker), and 9 (Reject).

- **To assign a rating from 1 to 5**, click on one of the five stars (Windows) or one of the five dots (OS X). You can also use the Up and Down arrows, or keys 1 through 5 on your keyboard, to rate images (pressing 0 resets the rating).

If you use Adobe Lightroom, you can also use the P (Save), U (Cancel), and X (Reject) keys to assign selection markers.

Comparing images

In full-screen mode, you can compare an image in two ways: via Quick comparison, that lets you switch between two versions of the image, or Split view, which uses a movable separation line between the two images. You can also select a reference image.

**Quick comparison**

To instantly compare a corrected image with the uncorrected original, click on the Quick compare button on the right side of the toolbar. You can also use Ctrl+D (Microsoft Windows) or D (OS X).

**Split view**

Activate the separation line by clicking on the Split view button on the right side of the toolbar. After it is displayed, you can move it anywhere within the image from left to right. The left part is the image before correction, and the right part is the image after correction.

You can switch to horizontal mode either by clicking on the second button while the mouse is hovering over the Split view button, or by
double-clicking on the handle in the center of the line. In the horizontal mode, the image before correction is on top, and the version after correction is on the bottom.

To leave Split view mode, click on the corresponding button in the toolbar.

Zoom at 100% works with both the Quick comparison and Split view modes.

Reference image

Full-screen mode also gives you the possibility of comparing a reference image to another version of the same image — for example, a virtual copy that was processed differently, or an exported version with applied corrections.

Click on the arrow located on the extreme right in the toolbar, and select the image to compare from the menu.

You can also use reference images in Quick comparison as well as Split view mode, when you have activated the latter, the reference image is on the left (or if you are in horizontal mode, on top).

Show/hide shooting parameters

To display the EXIF data of the selected image, click on the button on the bottom right of the screen, or press on your keyboard’s I (for “Information”) key. Click the button or press the key again to hide the EXIF data.

Show/hide help and list of keyboard shortcuts (full-screen mode)

To see the list of full-screen keyboard shortcuts, click on the question mark on the lower right, or press the F1 key (Windows) or Cmd + ? (OS X). Click / press again to hide.

The command bar

The command bar contains buttons and menus that let you navigate among the DxO PhotoLab tabs, determine the way in which your image will be displayed in the Viewer, and choose the level of zoom.

1. The tab selector, located above the command bar, lets you switch from one tab to the other.

2. Display modes
**Compare**: displays one image at a time in the viewer and the corrected image preview. You can also use Ctrl+D (Microsoft Windows) or D (OS X) to toggle between before and after corrections (the reference image will continue to be displayed while you hold down the shortcut keys or mouse button).

**Select reference image** drop-down menu (Microsoft Windows): lets you select a reference image for comparison purposes; menu choices are As Shot (default), Output Image, and Virtual Copy.

**Single image mode** (OS X): displays image with current settings.

**Dual image mode** (Microsoft Windows): lets you display an image before and after correction side-by-side.

**Full-screen (Viewer)**: Displays the image using the entire surface of the screen. To leave full-screen mode, press the Esc key (Microsoft Windows and OS X).

3. **Display size**

- **Zoom to fit** displays the entire image in available space in the Viewer.
- **1:1** displays the image at 100% (1 image pixel = 1 screen pixel).
- **Current zoom level** drop-down menu lets you change the zoom settings to predefined values or to enter your own zoom value.

4. **Presets**

- **Apply preset** button lets you bring up a visual palette of available presets and apply them to your image.
- **Reset** lets you return to the default preset correction settings.

**EXIF**

The EXIF information palette contains unchangeable image property information, followed by the EXIF editor, where you can enter author and copyright information.

**Image properties**

The list of image properties displays the information that the camera saves as image metadata. This information cannot be modified and is incorporated into every copy of the image. The list includes information about the brand and model of the camera used to shoot the image,
the size of the image in pixels, the date and time of the shot, the exposure mode, ISO sensitivity, exposure time, the exposure compensation value, use of flash, measurement mode, the lens type, focal distance, aperture, and GPS coordinates (if present in the image metadata).

**EXIF Editor**

The EXIF editor lets you add author and copyright information to the output image EXIF data.

- The unchangeable image properties and the editable Author and Copyright fields are grouped together in a single section in the OS.

- To protect your assets, we recommend that you add your name and copyright information to all your images before you publish or distribute them.

- For information about EXIF data specific to DxO ONE, see the Support for DxO ONE section in the user guide.
Managing your photos

- The source browser
- Virtual copies

The Source Browser

The Source Browser lets you explore the directories of your computer and its peripheral devices, as well as the projects stored in your DxO PhotoLab database.

In Windows, it is divided into four sections:
1. Find a folder
2. Folders
3. Projects
4. External selections of images shot with the DxO ONE camera and imported using DxO Connect (furnished with the DxO ONE).

OS X uses the Finder's sidebar classification system, with the following divisions: Devices, Shared, and Favorites. To these are added a Search field and a Projects folder, the latter containing any images taken with the DxO ONE and imported using DxO Connect.

Managing folders

Browsing folders (default function mode)

To display the contents of a folder, select it in the Source Browser: the images will be immediately displayed in the Image Browser. You can then likewise access the contents of a folder stored on your computer, on a connected external drive, or on a remote server.
Creating and renaming a folder

To create a new directory (Microsoft Windows only), right-click on the folder to which you want to add a folder and select the option Create a folder in the context menu. A folder called “New folder” will appear in the directory tree. To rename it, select the option Rename folder in the context menu.

Creating a folder in DxO PhotoLab also creates it on your hard drive, and you can verify its presence by right-clicking on the folder and choosing Open in Windows Explorer (Microsoft Windows) in the context menu. In OS X, use the Finder.

Searching for a folder

The Source Browser lets you directly display any folder that is stored on your hard drive, on a connected drive, or on a remote server. To do so, enter the name of your folder in the Search folder field, and the folder(s) will appear. Double-click on the name of the corresponding folder to display its contents in the Image Browser.

In Microsoft Windows, the search function returns the files indexed by Windows Search as well as non-indexed records that are already open in DxO PhotoLab. It is possible to use the Configure button to open the indexing configuration system window to add your image folders there. In OS X, the search function returns the files and volumes indexed by Spotlight.

The Image Browser displays only the images that are contained in the selected folder. Other files, such as system files or other data formats are not taken into account.

Copying and moving images

To copy one or more images in a Microsoft Windows folder, select the corresponding thumbnail(s) in the Image Browser and then drag and drop the image(s) into the destination directory. In OS X, do the same thing while pressing the Alt key. To move an image in Microsoft Windows, select it in the Image Browser and then drag and drop it into the destination directory while holding down the Shift key. In OS X, drag and drop it into the destination directory.

Managing projects

Projects let you gather together photos with different origins. They might not only be different from a technical point of view (shooting date, equipment used, exposure settings, etc.), but they can also come from different kinds of storage places — for example, your hard drive’s directory tree, a CD or DVD, a memory card, or another kind of storage device.

Browsing projects

In Windows, click on a project in the Projects section in the Source Browser: the contents of the project will be displayed as thumbnails in the Image Browser. The number displayed at the right of the project indicates the number of images included in the project. In OS X, the projects are part of the folder directory tree in the Source Browser.

When you first start using DxO PhotoLab, the list of projects will be empty.
Creating or deleting a project

To create a project, click on the Add project [+] button in the header of the Projects section (Microsoft Windows): a new project that you can rename right away will appear in the list. In OS X, when you click on the Project label in the Source Browser directory tree, a command bar will appear right underneath; click on the + button, and a project that you can rename right away will appear in the directory.

To create a project from a certain number of images, select the images in the Image Browser. Right-click and choose Create project from current selection in the context menu. In Microsoft Windows, the new project will be added to the Projects section in the Source Browser, where you can give it a name. In OS X, a dialog box prompts you to name your new project.

Projects are displayed in alphabetical order, but you can rename them at any time, either by clicking directly on the name, or by right-clicking and choosing Rename project in the context menu.

To delete a project in Microsoft Windows, select it in the list, click on the trashcan icon or right-click and choose Delete selected project in the context menu. A dialog box will ask you to confirm the operation. In OS X, when you click on the Project label in the Source Browser directory tree, a command bar will appear right underneath; then click on the minus sign [–]. A dialog box will ask you to confirm the operation.

Adding images to an existing project

To add images to an existing project, select one or more in the Image Browser (Ctrl/Cmd+click or Shift+click), then right-click and choose Add current selection to a project, and then, finally, choose the project to which you want to add the images. You can choose your project from the list of recent projects, or use the Other projects command to display the complete list of projects in a floating window.

When a project is open, you can also drag and drop images into it from Windows Explorer or from the OS X Finder.

You can also use drag-and-drop to add images to a project: select one or more thumbnails in the Image Browser and drop them onto the name of your project.

The commands Create project from current selection and Add current selection to a project are accessible in both the Organize and the Customize tabs.

The Image Browser command bar will display, from left to right, the name of the selected project, the number of photos selected, and the number of photos in the project. You can add as many photos as you want to a project, and you can also assign the same photo to several different projects.

A photo that is assigned to several projects is not physically duplicated. If a photo has been added to several projects and you remove it from one of the projects, the photo will not be removed from the other projects. Removing a photo from a project does not delete the original file. If you change or correct a photo that belongs to several projects, the changes will be applied to the image for all the projects. If you want to apply different settings or corrections to the same image that belongs to several projects, you should make as many virtual copies of the photo as you need.

Virtual copies

About virtual copies

A Virtual copy is a duplicate of a Source image on which you can try out various corrections. You can create and experiment with as many virtual copies as you wish to apply many different correction settings and compare them to one another.
Creating or deleting virtual copies

To create a virtual copy:
1. Choose the image you want to make a virtual copy of in the Image Browser.
2. Right-click on its thumbnail and select *Create a virtual copy* in the contextual menu. You can also choose the same command in the Image menu, or use the keyboard shortcut Ctrl + J (Microsoft Windows) or Cmd D (OS X).
3. A new thumbnail will appear in the Image Browser next to the image source (per default sort criterion "file name"; using different sort criteria can result in a different order).
4. The original will show the sequence number 1 in the lower left corner of the thumbnail, and each virtual copy will be assigned a sequence number (2, 3, 4, and so on).

Virtual copies behave exactly like an original image: you can organize them in projects (along with original files), apply any correction or preset, process them by exporting, and print them.

To delete a virtual copy:
1. Right-click on the copy thumbnail in the Image Browser.
2. Choose *Delete* in the context menu.

You cannot delete a virtual copy while you are working in the project to which it belongs. You can remove it from the project, but it will still exist and be visible when you open the folder containing the original image.

Using a virtual copy as a reference image

The previous steps explained how to create (unlimited) virtual copies which you can compare, one at a time, to the source or original image. But you might want to go a step further and compare virtual copies among themselves without having to use the source image. To do so, follow these steps:
1. In the upper command bar (in either the Customize or Organize tab), click on the tiny arrow located to the right of the *Compare* button (Microsoft Windows), or on the *side-by-side* display button (OS X), which will give you access to the Reference Image menu.
2. A list of all of the copies of the image in the Viewer will be listed in this menu. Some may be grayed out and marked as *Needs to be processed*; others may be active.
3. Choose one image from the active set. This image is now the reference image, and will appear on the left side of the comparison display. You can compare these virtual copies without having to go through the source image.
Finding your images

The Image Browser

The Image Browser displays the contents of a folder or project selected in the Source Browser (left-hand pane). A given thumbnail selected in the Image Browser is displayed in the Viewer.

The Image Browser (docked)

Image thumbnails in the Image Browser are displayed horizontally, and you can navigate through them using the scroll bar, or with your input device (mouse scroll wheel, trackpad, etc.). You can adjust the size of the Image Browser by moving the line between it and the Viewer.

The Image Browser (undocked)

You may find it advantageous to undock the Image Browser, especially if you use a second screen.

- To detach the Image Browser, go to View > Undock Image Browser (keyboard shortcut Ctrl/Cmd+U).
- To reattach the Image Browser, go to View > Dock Image Browser (keyboard shortcut Ctrl/Cmd+U).

The undocked Image Browser appears as a floating window that you can position freely on your principal monitor (or on your second monitor if you have a dual display). Moving the Image Browser will increase the vertical size of the main display pane. The undocked Image Browser can be resized, and the scroll bar will be located on the right side. The navigation buttons are still available and you can set the size of the thumbnails with the slider located on the right side of the Image Browser command bar.

The Image Browser command bar

1. **File name** or **active project**, and name of the image (either selected or mouse-overed).

2. **Sorting and filtering options**:
   - **Sorting images**: Photos in the Image Browser can be classified using different criteria (more details in the "Sorting images" paragraph below) and displayed accordingly.
   - **Filtering images**: This button acts as a display filter (see the paragraph on "Filtering images" below).

3. **Navigation buttons** let you go forward or backwards when viewing images in a project or folder, and to go directly to the first or last images in a project or folder.
4. **Number of selected images/Total images** in the project or folder displayed in the Image Browser.

5. **Export progress button**: By default, this button displays a small progress bar. By clicking on the button, you can open the floating progress palette that contains the progress bar(s) and details of the export(s) in progress or completed. You will see the progress button and bar only after you have started an export.

6. **Print**: Launches the print module.

7. **Export to disk**: The drop-down menu immediately to the left of this button lets you export your images to your hard disk, to an external application of your choice, a Facebook album, to a Flickr gallery or to Lightroom.

While the Image Browser is undocked, it will display a slider in its command bar that will let you resize the thumbnails.

**Image Browser information messages**

When the Image Browser is empty, you will see a message explaining why there is no image or thumbnail visible:

- No image in this folder meets your filtering criteria.
- This folder does not contain any images.

**Sorting images**

Sorting images works in the same way whether they are saved in a folder or gathered together in a project: you can choose the order in which they are displayed (from left to right) as thumbnails according to the following criteria found when you click on the **Choose the item sort order** button:

**Microsoft Windows**

- **Image Addition Order**: By the order in which images were added to the project.
- **Format (RAW/RGB)**: Sorts and lists RAW and RGB images when in the same folder or project.
- **File Name**: By the name of the file in alphanumeric order.
- **File Format**: By file extension (.JPG, .TIFF, .NEF, .CR2, etc.) in alphabetical order.
- **File Size**: By file size in MB.
- **Date**: By shooting date, creation date, or change date; practical for finding the most recent images in a folder or project.
- **Image Size**: In pixels (height x width).
- **Camera body**: By camera model.
- **Lens**: By lens model.
- **Rank**: By number of stars
- **ISO Speed**: By ISO sensitivity.
- **Virtual Copy Number**: Groups all virtual copies and originals in alphanumeric order (for example, all virtual copies marked no. 2 are grouped together, followed by those marked no. 3, etc.; the number 1 is reserved for originals).
- **Processing State**: By the 4 possible options (awaiting processing, error, processed, waiting to be processed) – only if this option has been activated in DxO Edit > Preferences > Display.

**OS X**

- **File Name**: By the name of the file in alphanumeric order.
- **Image Addition Order**: By the order in which images were added to the project.
- **Format (RAW/RGB)**: Sorts and lists RAW and RGB images when in the same folder or project.
- **File Format**: By file extension (.JPG, .TIFF, .NEF, .CR2, etc.) in alphabetical order.
- **File Size**: By file size in MB.
- **Creation Date**: By shooting date, creation date, or change date; practical for finding the most recent images in a folder or project.
- **Image Size**: In pixels (height x width).
- **Camera body**: By camera model.
- **Lens**: By lens model.
- **Rank**: By number of stars.
- **ISO Speed**: By ISO sensitivity.

Images that are not displayed cannot be selected for correction or processing.
Thumbnail icons

Normally, the Image Browser thumbnails display only the file name and when appropriate, an icon of an image being exported. Other icons will display if there are problems that you need to know about.

1. **DxO Optics Module status** icons. The following icons indicate the status of DxO Optics Modules associated with each image:
   - DxO Optics Module unavailable.
   - DxO Optics Module available for downloading.
   - DxO Optics Module ambiguity (in this case, clicking on the icon will open a dialog box in which you can resolve the ambiguity, as in the case of two lenses with very similar characteristics, for example).
   - DxO Optics Module ambiguity resolved.

2. **Pick and Reject** tag. These markers are inactive by default. They indicate the images you choose to save (green dot) and the ones you reject (red dot). If you don’t choose a selection marker, the dot is grey.

3. The **processing status** icons. The following icons indicate the processing status of images:
   - Information about the image status:
     - The correction of the image was changed after export (Microsoft Windows only).
     - The photo cannot be processed because it is too small, either because the file format is not supported (as with DNG files from unsupported cameras, for example).
   - Processed image.
   - Processing error.
   - The photo is being processed.
   - The photo is waiting to be processed.

4. **Virtual copy ID number.** Displays the sequence number (1, 2, 3, etc.). for virtual copies, with number 1 always reserved for the original image.

5. **Delete** (recycle bin) icon. Lets you delete images from your hard drive or remove them from a project.

6. **Ranking.** You can grade or rank to your images by assigning a number of stars (from 0 to 5) to each one; you can then use these rankings to filter your images.

7. **PRIME** badge. Indicates if the image is to be processed using PRIME noise reduction when exported.
You can display, hide, or show these icons when mousing over a thumbnail. You can find these settings in the Preferences.
Filtering & Selecting the best images

- Filtering images with the image browser
- Selecting the best images with the Full-screen mode
Thumbnail icons

Normally, the Image Browser thumbnails display only the file name and when appropriate, an icon of an image being exported. Other icons will display if there are problems that you need to know about.

1. **DxO Optics Module status** icons. The following icons indicate the status of DxO Optics Modules associated with each image:
   - DxO Optics Module unavailable.
   - DxO Optics Module available for downloading.
   - DxO Optics Module ambiguity (in this case, clicking on the icon will open a dialog box in which you can resolve the ambiguity, as in the case of two lenses with very similar characteristics, for example).
   - DxO Optics Module ambiguity resolved.

2. **Pick and Reject** tag. These markers are inactive by default. They indicate the images you choose to save (green dot) and the ones you reject (red dot). If you don't choose a selection marker, the dot is grey.

3. The **processing status** icons. The following icons indicate the processing status of images:
   - Information about the image status:
     - The correction of the image was changed after export (Microsoft Windows only).
     - The photo cannot be processed because it is too small, either because the file format is not supported (as with DNG files from unsupported cameras, for example).
   - Processed image.
   - Processing error.
   - The photo is being processed.
   - The photo is waiting to be processed.

4. **Virtual copy ID number**. Displays the sequence number (1, 2, 3, etc.) for virtual copies, with number 1 always reserved for the original image.

5. **Delete** (recycle bin) icon. Lets you delete images from your hard drive or remove them from a project.

6. **Ranking**. You can grade or rank to your images by assigning a number of stars (from 0 to 5) to each one; you can then use these rankings to filter your images.

7. **PRIME** badge. Indicates if the image is to be processed using PRIME noise reduction when exported.
You can display, hide, or show these icons when mousing over a thumbnail. You can find these settings in the Preferences.

Selecting the best images with the full-screen mode (Viewer)

Full-screen mode lets you display the image by itself, without any UI elements, so you can easily compare a reference image with another (before correction, virtual copy, etc.), and rate or assign selection markers to your photos.

Full-screen mode

You can activate full-screen mode by:

- Clicking on the corresponding full-screen button in the command bar.

- Selecting Full-screen (Viewer) in the Display menu.

- Using the keyboard shortcut F12 (Microsoft Windows) or Cmd+Maj+F (OS X).

Full-screen mode is accessible in both the Organize and the Customize tabs.

Displaying images
To navigate from one image to another, use the left and right arrow keys on your keyboard.

To delete an image, press the Delete key (Microsoft Windows) or Cmd+Delete (OS X).

To fit the image to the screen, use the F3 key (Microsoft Windows) or Cmd+0 (OS X).

To display the image at 100%, press F4 (Windows) or Cmd+1 (OS X).

To change from Fit-to-screen to 100%, or the reverse, double-click in the image.

In Windows, full-screen mode is equipped with a navigation loupe for when you are zoomed in on the image. To activate or deactivate it, click on the button on the bottom right, and then click on Navigation. As soon as you zoom in on the image, you can navigate within it by placing the tile in the loupe window.

Assigning selection markers and ratings

If you click on the central button (with a chevron on it), you will display the toolbar with the file name and type, and an image selection and rating bar. To hide these, click on the same button.

- To assign a selection marker, click on the icons located under the image: the green “Tag” dot is on the left; the red “untag” dot is on the right. Simply click on the colored dot again to get rid of the selection marker.

- You can also use these keys on your keyboard to assign selection markers: 7 (Save), 8 (no marker, unassign marker), and 9 (Reject).

- To assign a rating from 1 to 5, click on one of the five stars (Windows) or one of the five dots (OS X). You can also use the Up and Down arrows, or keys 1 through 5 on your keyboard, to rate images (pressing 0 resets the rating).

Comparing images

In full-screen mode, you can compare an image in two ways: via Quick comparison, that lets you switch between two versions of the image, or Split view, which uses a movable separation line between the two images. You can also select a reference image.

Quick comparison

To instantly compare a corrected image with the uncorrected original, click on the Quick compare button on the right side of the toolbar. You can also use Ctrl+D (Microsoft Windows) or D (OS X).

Split view

Activate the separation line by clicking on the Split view button on the right side of the toolbar. After it is displayed, you can move it anywhere within the image from left to right. The left part is the image before correction, and the right part is the image after correction.
You can switch to horizontal mode either by clicking on the second button while the mouse is hovering over the Split view button, or by double-clicking on the handle in the center of the line. In the horizontal mode, the image before correction is on top, and the version after correction is on the bottom.

To leave Split view mode, click on the corresponding button in the toolbar.

Zoom at 100% works with both the Quick comparison and Split view modes.

Reference image

Full-screen mode also gives you the possibility of comparing a reference image to another version of the same image — for example, a virtual copy that was processed differently, or an exported version with applied corrections.

Click on the arrow located on the extreme right in the toolbar, and select the image to compare from the menu.

You can also use reference images in Quick comparison as well as Split view mode; when you have activated the latter, the reference image is on the left (or if you are in horizontal mode, on top).

Show/hide shooting parameters

To display the EXIF data of the selected image, click on the button on the bottom right of the screen, or press on your keyboard’s I (for “Information”) key. Click the button or press the key again to hide the EXIF data.

Show/hide help and list of keyboard shortcuts (full-screen mode)

To see the list of full-screen keyboard shortcuts, click on the question mark on the lower right, or press the F1 key (Windows) or Cmd + ? (OS X). Click / press again to hide.
Roughing

- Horizon
- Crop

Horizon

The Horizon tool lets you automatically or manually straighten out a slanted image.

Automatic mode:

1. Click on the magic wand to the right of the Horizon slider.
2. To cancel the automatic correction, click again on the magic wand.
3. To modify or fine-tune the correction, use the Horizon slider.

Manual mode:

This user-friendly tool, also available in the command bar, lets you easily straighten out a tilted horizon:

1. Click on the Horizon button.
2. Superimpose the reference line on the tilted horizon by placing the anchor points on the desired areas.
3. You can also trace a new reference line in the image and refine its position by moving the anchor points to the desired locations.
4. If you have enlarged the view by zooming in, you can navigate in the image by using the Move/Zoom palette.
5. Click on the Preview button on the lower right, underneath the image, to return to the default view.
6. You can cancel the correction and start over by clicking on Reset.
7. Validate the correction by clicking on the Apply button.
You can also directly apply the correction without going into preview mode first.

The Horizon tool is also very practical for applying slight rotations (less than 5°) to your image. To do so, you can use the slider or you can enter a value.

**Crop**

An image whose perspective has been corrected by the Horizon/Perspective tools generally loses some information at the edges — a great deal more if the correction is significant. This is why the Crop palette is set to **Auto based on Perspective / Horizon** by default, and the aspect ratio is set to **Preserve aspect ratio**, meaning that cropping is performed automatically on the corrected image, retaining as much information as possible.

- Selecting **Preserve aspect ratio** in the Aspect Ratio drop-down menu instead of Unconstrained will resize your image while maintaining its proportions (i.e. the relationship between its longer and shorter sides: for example 3:2 or 4:3).
- It is also possible to choose a different ratio in the **Aspect ratio** drop-down menu, such as 1:1 (a square format), 5:4 (replicating the traditional 5×4 or 10×8 format), or any other in the list. You can also type a ratio (2 figures separated by a colon) directly in the menu bar.
The grid display is activated by default.

Manual cropping

- If you click on the Crop tool button, a dotted-line crop box will display on the image. You can move or extend this box by dragging its corners. If you have chosen a specific aspect ratio, the box will display the proportions of this aspect ratio, and you will be allowed to change only one of its dimensions, the other tracking automatically. If you have chosen an unconstrained aspect ratio, you will be able to freely change both dimensions of the box.

- To adjust a crop, you can also click on the Crop tool button. Once Crop has been enabled, select a point in the image, hold down the left mouse button and drag to create a crop box: it will appear as a black rectangular frame within the image.

- Clicking on and dragging the corners of the box adjusts its size. Clicking inside the box lets you move it around.

- Clicking outside the box removes the box and lets you create a new box from scratch.

In OS X, if you have selected Unconstrained in the Aspect Ratio drop-down menu, holding down the Shift key will allow you to preserve the proportions. Conversely, if you have chosen Original (which preserves the proportions), holding down the Shift key will let you move into Unconstrained mode.

When the crop tool is active, a command bar is displayed below the Viewer pane. From there, you can select a predefined aspect ratio, type in your own values, show or hide the grid overlay, reset and close the tool.

When you manually crop, the dimensions in pixels are displayed in the lower-right corner of the frame. You can choose a predefined aspect ratio for your image, or enter a custom ratio, display or hide the “rule of thirds” grid, reset the crop, or close the tool.

You can apply the settings and close the tool by pressing the Enter key, or reset the crop and close the tool by pressing the Escape key.
PRESETS

About DxO PhotoLab presets

A preset is a set of corrections that you can apply in one go to any pictures in DxO PhotoLab. The goal of the presets is to help you to record and keep track of your favorite corrections, and to ease and accelerate your workflow within the application.

There are two kinds of presets in DxO PhotoLab:

- **Full presets** cover all the existing corrections available in the Customize tab, meaning that each correction has a status of either activated (with defined setting parameters) or deactivated.

- **Partial presets**, on the other hand, cover only a limited number of corrections among all existing corrections, with the status of some corrections remaining undefined.

As soon as you open an image in DxO PhotoLab, the default full preset DxO Standard is automatically applied. You can choose a different preset as the default if desired.

The different categories of available presets

DxO PhotoLab offers a set of 30 full presets divided into eight categories:

**General use**

The General use category comprises four presets:

- **DxO Standard**, which is systematically applied by default to your images as soon as you open their respective folders in the Source Browser, and includes the following corrections:
  - DxO Smart Lighting on Slight.
  - Color rendering unchanged for JPEGs, camera default rendering for RAW files.
  - Protection of saturated colors on Auto.
- Noise reduction on Auto.
- Distortion on Auto.
- Vignetting on Auto.
- Chromatic aberration on Auto (and lateral chromatic aberration correction activated).
- Lens softness activated, Global slider on 0, and both the Details and the Bokeh sliders set to 50 (or Sharpness Mask default settings, if a DxO Optics Module is not available).

- **Neutral colors** is identical to DxO Standard, except that the colors are less saturated and the contrast is less pronounced.
- **Black & White** automatically converts a color image based on its content.
- **No correction** deactivates all of the corrections in DxO PhotoLab, so images are displayed “as shot.” In the case of RAW files, DxO PhotoLab still performs demosaicing using all of the basic settings that are optimal for your camera.

You can change the default preset in Preferences. The new default preset will be applied only to images that you process after making the change, not to images that were already opened with the previous or original default preset.

**Portrait and Landscape**

The Portrait and Landscape category is composed of two groups of presets that have been designed for these two use cases. For portraits, for example, the contrast is softer and the skin tones have been optimized, whereas for landscapes, the contrast and the colors have greater emphasis. The following eight presets are available in this category:

- Portrait - Standard
- Portrait - Bright
- Portrait - Candy colors
- Portrait - High key
- Landscape - Standard
- Landscape - Polarized postcard
- Landscape - Contrasty
- Landscape - Washed out

**Black & white**

The Black & White category also provides eight presets that let you modify your images by playing with the contrast. You will find here presets that are adapted for “masculine” and “feminine” portraiture and for landscapes, presets that produce highly-detailed images, and others which are shrouded to give a dream-like effect. Of course, all of these presets can be applied to any subject:

- B&W - Dense
- B&W - Structured
- B&W - Dramatic skies
- B&W - Low key
- B&W - For her
- B&W - For him
- B&W - Subdued
- B&W - Veiled

**Atmospheres**

The Atmospheres category offers eight creative presets based on toning. They can be applied to both color and black & white images:

- Mist
• London night
• Blue hour
• Twilight
• Old film
• Polar
• Heather purple
• Old school
High Dynamic Range (single-shot HDR)
This category contains four presets that simulate HDR effects - that is, images with an extended dynamic range but with a tonal range that is redistributed to be used without having to use special software or 32-bit files. These single-shot image presets do not require combining multiple images shot at different exposures, and can be used on both RAW and JPEG files:

- HDR - Realistic: Provides a less-pronounced HDR effect than the preset immediately preceding. Restores highlights, lightens shadows, and has a reasonable effect on the tone curve and vibrancy.
- HDR - Artistic: Provides a marked HDR effect. Restores highlights, strongly brightens shadows, and emphasizes the tone curve and vibrancy.
- HDR - Backlight correction: strongly lightens shadows under backlighting conditions, while still preserving a natural look.
- HDR - Black & White: Optimized for monochrome images, this effect strongly accentuates contrast.

Smartphones
This category contains two presets that have been optimized for images taken with mobile phones.

- Smartphones - Low ISO
- Smartphones - High ISO

DxO FilmPack Designer
This category contains the Designer presets available in DxO FilmPack. These presets are based on analog film renderings and graphic effects - filters, toning, vignetting, textures, flaws - which bring a new artistic dimension to your images. Up to 16 black & white and 23 color presets are available, depending on your edition of DxO FilmPack (ESSENTIAL or ELITE).

DxO ONE scene modes
This preset category lets you apply the renderings of DxO ONE scene modes to any photos processed in DxO PhotoLab:

- DxO ONE - Auto
- DxO ONE - Portrait
- DxO ONE - Landscape
- DxO ONE - Night
- DxO ONE - Sport

Applying a preset

Applying a predefined preset
To apply a preset to your image, click on the Apply a preset button in the command bar. Doing so opens a window in which all of the available presets and their affects on the selected image appear.

Combining presets
You can use more than one preset on an image. If each preset has a different value for the same correction, the rule is simple: The values of the last applied preset take precedence; for example:

- If the first-applied preset gives a value of Disabled for a correction, and the second preset gives the value of Enabled to the same correction, the correction will be Enabled (that is, active).
- If both corrections are set to Enabled, with the first preset supplying a value of, say, “−2,” and the second preset supplying a value of “+1,” then the correction value will be “+1.”
This rule in particular makes it possible to create partial presets that are based on a limited range of corrections to be applied on top of “overall” (or full) presets. When a correction is assigned a value by the partial preset, it will be governed by it. When there is no value assigned to a correction by the partial preset, the correction will be governed by the underlying full preset.

Creating a full preset from current settings

To create a preset from current settings:
1. Correct your image.
2. When you are satisfied with the results, right-click on the image thumbnail in the Image Browser, and select Create preset from current settings in the context menu.
3. Enter a name for your preset in the dialogue box and click on Save.
4. The new preset will appear in the Visual Presets window and in the list in the Preset Editor.

Any preset that you create in this manner will affect all setting values, as it is a full preset.

Managing presets with the Preset Editor (ELITE Edition)

The Preset Editor is a palette in the Customize tab that lets you create and manage your own custom presets, including those that you create "from scratch," and others that you can create by modifying existing presets.

Preset Editor commands

Microsoft Windows

The Preset Editor lets you create a preset by defining each correction setting:

- **New preset group**: Creates a folder in which you can group similar presets: by type of camera used, speed rating, landscape rendering, portrait, etc. (You can use drag and drop to move presets from one folder to another.)

- **New preset from current settings**: Lets you create a preset from the corrections you have made on the image displayed.

- **Duplicate the selected preset**: Makes it easier to create a preset by using an existing preset (you will need to use this method if you want to create variants of a locked DxO preset).
• **Delete**: Deletes the selected preset or folder.

• **Import**: Lets you import presets from an older version of DxO PhotoLab or created on a different computer.

• **Export**: Makes it easy to export a preset to a folder that will be copied onto another computer or sent via email.

• **Edit**: Lets you modify a preset (ELITE Edition).

• **Apply**: Lets you apply the preset to the selected image.

• **Save**: Lets you save changes to a preset (this command appears only in Edit mode).

• **Cancel**: Lets you cancel the changes you made to a preset (this command appears only in Edit mode).

• **New empty preset** (only from the context menu and only in the ELITE edition): Creates an empty preset that contains no settings. The preset is created in a folder that you choose in advance.

---

A locked preset (marked with a padlock icon) is one that is provided by DxO PhotoLab, so you cannot modify or delete it.

You can create as many presets as you want and save them in custom folders, import them into other sessions or versions of DxO PhotoLab, and export them to share them with other users.

---

To verify or to change a preset's settings, select it in the Preset Editor and then click on Edit: the relevant palettes will then be displayed in edit mode.

---

OS X

A drop-down menu located in the upper right corner of the palette offers the following commands (also available in the editor by right-clicking on the preset): New preset from current settings, New empty preset, New group, Duplicate preset, Rename, Delete, Apply preset,
Edit preset, Save, Save copy, Cancel changes, Import [note that importing several presets simultaneously is possible], and Export.

Modifying a preset from an existing preset (ELITE Edition)

Microsoft Windows and OS X

To create or to change a preset based on an existing preset:

1. Click on the preset that you want to change.
2. Click on the Edit button on the top left of the Preset Editor palette. The relevant correction palette tools will switch to editing mode (indicated by blue banding on the left edge of the palettes).
3. Uncheck the settings in the palettes that you want to deactivate, or modify the setting parameters as desired. You can expand the hidden palettes to activate, deactivate, or modify their settings.
4. When you are finished making all the changes to the settings, click on the Save button in the Preset Editor palette.
5. Click again on the Edit button to quit the create/edit preset mode.

The tool palettes in edit mode

To create a variant of a locked DxO preset, click on the Copy button in the command bar of the Preset Editor and then rename the copy.

In all cases, changes to preset parameters can be canceled either by selecting Undo in the Edit menu or by using the Ctrl (Windows) / Cmd (OS X) + Z keyboard shortcut.

Preset folders (ELITE Edition)

You can open folders in the preset folder list by either double-clicking on them, or by a single click on the arrow on the top left. Clicking on the name of a folder lets you rename it, just like the way you rename a file. Preset folders are ordered alphanumerically. We recommend that you give your folders meaningful names so that you can easily group and find your presets.
Basic Editing (Tone/Color)

Histogram
- About the histogram

Tone
- Exposure Compensation
- Contrast
- DxO Smart lighting
- Selective Tone
- DxO ClearView (ELITE Edition)

Color
- White Balance

About the histogram

The histogram shows, color by color, how many pixels there are for each level of luminance. The three color channels (RGB) and the Luminance channel can be displayed separately.

The histogram is the best tool to determine how a picture has been exposed, in order to help you to correct it properly. Basically, a histogram is a chart that shows the number of pixels for each level of luminance. The taller each vertical line, the more pixels with that value in the image. When the peaks are mostly located on the left side, it is a dark image. When they are mostly on the right side, the image is bright. When the vertical lines are spread from the left to the right, with a bump in the middle (for the midtones), the photo is balanced, and the full dynamic range is covered.

RGB and L channels
The histogram tool calculates the brightness values for each color channel, and displays them all together on the same chart. However, you can also display the values per channel, as your camera does, by clicking on one of the buttons located on the right side of the chart:
- RGB: Displays all the channels together (RGB and Luminance).
- R, G, or B: Displays the Red, Green or Blue channels accordingly.
- L: Displays the global Luminance channel

When you mouse over the image, the histogram palette shows the RGB values for that portion of the image, on a 0 to 255 scale, and the actual color is shown in a patch. This is very useful for determining which channel is dominant and thus helps to detect colorcasts.

**Clipping**

When a luminance level goes below the left end of the histogram - the so-called black point, or above the right end - the white point, it will be constrained to pure black or pure white. Pixels in this position, or close to it, are said to be "clipped." This situation can occur if the scene contains very dark areas, and if you expose for the bright tones: in that case, the dark tones will be clipped. Conversely, if the scene contains very bright areas and you expose for the mid or dark tones, the highlights will be blown out, and all the relevant details may be lost. The Histogram palette offers two clipping visualization tools, both located below the histogram chart:

- Shadow clipping: Clicking on the icon will display, in false colors, the zones where no (or only some) information is left in the dark area's color channels.

- Highlight clipping: Clicking on this icon displays clipped or close-to-clipped bright areas.

When all three color channels have reached their maximum values, the corresponding clipped bright zone is displayed as a false black on the image. When there is some information left in one of the color channels, the affected zone is displayed in other false colors.

**Exposure Compensation**
The image on the left is overexposed globally, with burnt areas in the background.
The image on the right shows the result achieved with the “Center-Weighted Average” in the Exposure Compensation palette.

Exposure Compensation adjusts the image exposure level—that is, it increases or reduces the brightness coefficient of each pixel in the image. Since a photographic system can capture only a fraction of the tonal range in the real world, most photos will have under- or over-exposed zones—or both at the same time.

Overexposure presents the biggest problem in digital photography, since a saturated camera sensor cannot cope with brightness above a certain level and returns all-white pixels. The Exposure Compensation tool can often recover information in these areas that have been incorrectly exposed, particularly with respect to RAW images, whose color channels generally retain some information even for burnt areas. With JPEG images, which have already undergone a series of in-camera processes relative to each RGB channel, however, highlights that are lost are gone for good.

Correcting a RAW file

There are three automatic correction modes for priority highlight recovery: slight, medium, and strong.

The Correction drop-down menu, specific to RAW-format images, proposes five automatic correction modes and one manual option:

- **Highlight Priority** automatic mode: Deals with highlights at three different levels of recovery: slight, medium, and strong. Whichever correction you choose, be sure to verify the results in the histogram.

- The **Center-weighted average** option: Optimizes the correction process (exposure adjustment) at the center of the image.

- **Manual** (correction by default when Exposure compensation is activated): Requires the use of the Exposure slider, which has a range from −4 EV to +4 EV (1 EV, or “exposure value,” is the equivalent of one f-stop). Moving the slider to the right brightens the image, while moving to the left darkens it.

Choosing one of the automatic exposure options can speed up your workflow by providing custom settings for many types of shooting situations. For example, the “slight” correction is usually enough to deal with a normally-contrasted image.

Correcting a JPEG or TIFF file

JPEG and TIFF files can be corrected in manual mode using the Intensity slider, whose range goes from −4 EV to +4 EV.

Move the slider in small steps while monitoring the changes in the histogram, with the highlight zone visibility button (below the histogram on the left) activated so you can see if the exposure has been increased too much (some clipped zones appear) or not reduced enough (clipping still visible).
**Contrast**

The Contrast sub-palette consists of the **Contrast** and **Microcontrast** sliders.

If DxO FilmPack 5 (ELITE Edition) is installed, four other sliders will also be present: **Fine contrast** and three advanced settings tied to it: **Highlights**, **Midtones**, and **Shadows**.

- **Contrast**: This is the global contrast that acts on the entire image. DxO PhotoLab corrects this by applying a classic S-shape tone curve that contracts the deep shadows and the brightest highlights while stretching the midtones. This correction is implemented using a slider whose most extreme values are –100 and +100.

The global contrast correction can interfere with the Tone curve settings.

- **Microcontrast**: also known as "local contrast," it can be measured in small homogeneous regions that the software automatically detects. Improving the local contrast provides results that are similar to the sharpness correction, without the disadvantage of generating artifacts around the edges. Microcontrast brings out the details and gives the image more "bite." It is ideal for landscape, architectural, and industrial photos.

You can adjust the Microcontrast in two ways:

- Manually, by moving the slider to the right (stronger), or to the left (weaker).
- Automatically, by clicking on the magic wand to the right of the slider.

Automatic mode takes into account the presence of faces in order to preserve them, and also takes into account digital noise so as to avoid accentuating it excessively. For JPEG images, automatic **Microcontrast** is limited to a value of +5.

To reset the automatic correction, click again on the magic wand.

- **Fine contrast** (DxO FilmPack 5 ELITE Edition installed): The Fine contrast slider brings out or softens medium-sized details, and is gentler in its effects than the Microcontrast, slider, making it appropriate to use with portraits.

- **Advanced settings** (DxO FilmPack 5 ELITE Edition installed): The Advanced Settings section offers three additional sliders for Fine contrast that act in a selective manner on the following three light ranges:
Each slider range goes from –100 to +100, with the default value set at 0.

DxO Smart Lighting

About DxO Smart Lighting

Backlit subjects are a typical case that calls for DxO Smart Lighting correction. Here, because of the very strong contrast, a high level of correction has been applied to open the shadows – as if a fill-in flash had been used.

Ordinarily, image corrections are applied to the whole photograph: when you modify the brightness or the contrast, you make the whole image brighter, darker, and more or less contrasted.

DxO Smart Lighting's **Uniform** mode lets you automatically brighten or darken certain areas in your image without affecting other areas. You can also modify the contrast wherever necessary, such as in the following cases:

- Images with areas that are backlit.
- Images with a contrast range markedly higher than a camera can handle, especially images with very dark areas.
- Images that were accidentally underexposed, generally short on contrast, or lacking a flash fill-in.

As for **Spot Weighted** processing, it uses face detection and works with Smart Lighting to give priority to correctly exposing faces. This is not precisely a local correction, but rather a way to weight the exposure in favor of faces while preserving the correct exposure of the rest of the image, for a balanced and natural result.

DxO Smart Lighting: Uniform mode
DxO Smart Lighting's Uniform mode offers three levels of correction which take care of the vast majority of cases.

As with the majority of corrections, DxO Smart Lighting's Uniform mode functions automatically. In this case, the software analyzes the image content and applies the correction in a homogenous way. You have two tools you can use either together or separately to adjust the correction:

- The first is a drop-down menu that lets you modify the intensity of the correction by choosing among four different levels: **Strong**, **Medium**, **Slight** (default setting), and **Custom** adjustments.

- The intensity slider is set at the value assigned to the chosen automatic correction mode: 25 for Slight (default setting), 50 for Medium, and 75 for Strong. You can modify these slider settings, in which case the drop-down menu will display Custom mode.

DxO Smart Lighting: Spot Weighted mode
**DxO Smart Lighting Spot Weighted mode still offers three levels of correction, with one additional tool.**

**DxO Smart Lighting’s Spot Weighted mode** is based on detection of faces in a photo in order to optimize the exposure — without radically modifying the rest of the image. This feature is particularly useful in the following cases:

- Backlit faces.
- Faces that are too bright or too dark against the background, whether dark or bright (e.g., bright on a dark background, bright on a bright background, etc.).

When you click on the **Spot Weighted** button, **DxO Smart Lighting** will apply a correction in Slight mode by default, taking into account the faces present in the image. The number of areas detected is indicated in the sub-palette, to the right of the **Spot Weighted processing** tool.

To see the detected areas, click on the icon. In the image, each detected face is surrounded by a rectangle. If you move the mouse over one of these rectangles, it will activate (that is, its sides will appear as dotted lines and there will be handles in each corner), thus letting you move it, resize it, or delete it (for this last, click on the cross in the upper right corner of the frame).

You can also use the mouse’s cross pointer to draw a new area. When you do this, the software will perform a new analysis and apply a new correction to the image.

If the system doesn’t detect a face (or all of the faces) when you activate **Spot Weighted processing**, the message, “No face detected” will appear in the **DxO Smart Lighting** sub-palette. Generally speaking, non-detection occurs when a face is partially hidden or otherwise not directly facing the camera (for example, a profile shot). In these cases, you can manually draw a rectangle, and here, too, the software will perform a new analysis and apply a new correction to the image.

The toolbar located underneath the image lets you activate and deactivate the display of weighted areas (rectangles); to reset the
correction; or to close the tool (which you can also do by clicking on the icon in the sub-palette).

You can change the intensity of correction by choosing from among three predefined modes (Slight, Medium, Strong), or by using the Intensity slider to make manual adjustments. In every case, the algorithms take faces into account.

What settings should you use with DxO Smart Lighting?

DxO Smart Lighting is probably the most complex of our corrections. It has a global and a local effect on the image – affecting the whole picture and local details – and has a strong influence on contrast and brightness. Such a complex correction can only be mastered with practice. However, you will quickly see for yourself how effective DxO Smart Lighting is even for difficult images.

First, generally speaking, DxO Smart Lighting changes bright images only slightly, but has a stronger effect on darker images. It has little effect on highlights, unlike Exposure Compensation. Second, you should stick with the three automatic correction modes as much as possible, as they can cope with most situations, and then fine-tune with the Intensity slider afterwards. If you need to do further corrections, use the Selective tone palette or the Tone Curve.

Selective tone

The Selective tone palette

The Selective tone palette is a very intuitive and precise way to control and adjust the brightness of well-defined tonal ranges in an image:

- **Highlights**: This slider is designed to recover information and details in the brightest parts of the image (e.g., skies with bright clouds, the outside seen through an interior window pane).

- **Midtones**: This slider acts on the midtones, as represented in the central part of the histogram.

- **Shadows**: This slider lets you brighten the shadows and dark areas in an image.

- **Blacks**: This slider lets you set the black point (left end of the histogram) in your image. To the left, the slider progressively changes the dark areas to solid black and, to the right, progressively lifts the black levels and makes them brighter (the left end of the histogram will move to the right, leaving no image data in the blacks).

The Selective tone sliders can drastically change the contrast of your pictures. Use them in moderation and check your histogram to avoid clipping.

DxO ClearView (ELITE Edition)
Atmospheric haze is caused by heat, humidity, or pollution, and frequently causes problems in landscape photos by obscuring details and adversely affecting contrast.

The DxO ClearView tool automatically eliminates atmospheric haze in both RAW and JPEG files.

The **Intensity** slider, set at 50 by default, lets you choose the strength of the correction ranging from 0 to 100.

To return to the default setting (50), double-click on the slider.

---

**Color**

**White Balance**

Regardless of its origin (artificial or natural), light usually appears white to our eyes. It is, however, nothing of the sort. Even daylight can contain strong blue dominants, particularly in shadows or when the sky is overcast. On the other end of the spectrum, incandescent bulbs have a yellow cast, while fluorescent lights produce complex green casts. Adjusting white balance serves to correct these undesirable light dominants.

The **White Balance palette (Microsoft Windows)**

The settings available depend on the file type:

- **For a RAW file**, the white balance has yet to be established, and you can use any of the available tools in the palette.
- **For a TIFF or JPEG file**, the white balance has already been performed by in-camera processing (JPEGs), or by another software or image editor (TIFFs). Consequently, you are limited to using just the Pick Color eyedropper and the Temperature slider to adjust the White Balance correction.

When you select a RAW file or a RGB file (JPEG or TIFF) in the Image Browser, the White Balance palette automatically adapts accordingly.

Using pre-established settings (RAW files only)

The drop-down Setting menu contains a certain number of settings that cover most known light sources, ranging from daylight, cloudy, or shade to tungsten, different types of fluorescent, or industrial (sodium, mercury) lights.

The default choice is **Original**, which corresponds to the white balance of the camera used to shoot the image. **Manual** or **Custom mode** is automatically selected as soon as you use the **Color temperature** or **Tint** sliders (see the corresponding paragraphs further below).

The pre-established settings are:

- **Daylight** (Temperature 5,200 K, Tint 0) corresponds to light in the middle of a clear, cloudless day.
- **Cloudy** (Temperature 6,000 K, Tint 0) compensates for the slight coolness and blue dominant of a cloudy sky.
- **Tungsten** (Temperature 2.850 K, Tint 0) compensates for the strong orange dominant of light found in certain industrial sites, community halls, etc.
- **Fluorescent** (Temperature 4.000 K, Tint 0) compensates for the warm dominant of neon tubes.
- **Flash** (Temperature 6.100 K, Tint 0) compensates for the slightly blue light of an electronic flash.
- **Aquatic** (Temperature 15.000 K, Tint 150) compensates for the strong blue-green dominant in underwater photos.
- **Shadow** (Temperature 7.000 K, Tint 0) compensates for the marked cold dominant in photos taken in the shade.
- **Manual**: Activated when using the eyedropper.

Extending white balance to 50.000 allows for very specific corrections, such as those for the Aquatic preset that efficiently compensate for the strong blue-green dominant in underwater images.

The original white balance is the only camera setting that DxO PhotoLab takes into account.

Using the eyedropper (RAW or RGB files)

To use the eyedropper, you will first need to find an area or element in your image that is as close as possible to a neutral gray color, preferably a relatively light gray. Next, click on the area to establish the white balance. You can do this as many times as you want until you achieve the result you are looking for.

Zoom in on the image to facilitate picking a neutral area, which can be very small.

The **Radius slider** at the bottom of the Viewer lets you set the size of the sample area.

For images taken at high ISO speeds, we recommend increasing the Radius slider value to 10, to reduce pointing errors due to possible noisy patches.

After you finish using the white balance eyedropper, click on **Close** in the bottom right of the toolbar directly underneath the image.
Fine-tuning the white balance of a RAW file

However you choose to initially correct your images for white balance — via pre-established settings or the eyedropper, you can fine-tune the corrections using the Color temperature and Tint sliders. The Color temperature slider has a range of 2,000 °K to 50,000 °K, and can often be combined with the Tint slider to remove residual colorcasts.

In all cases, choosing As shot in the drop-down menu lets you safely revert to the settings provided by the image EXIF data.

Fine-tuning white balance for a RGB file (TIFF or JPEG)

When you select a JPEG or TIFF file in the Image Browser to set the white balance, the RAW white balance palette changes automatically to the RGB white balance palette, in which a simplified Color temperature slider is available in addition to the color picker. Strictly speaking, it is not possible nor recommended to set the white balance for a JPEG or TIFF file, since the white balance has already been established by in-camera processing. Therefore, any modification in one tonal range will produce imbalances in other tonal ranges: if we correct the midtone greys, then highlight greys or low-key greys will inevitably suffer a slight colored hue. You can use either the color picker (eyedropper — see above) or a dedicated slider, both available in the advanced settings (OS X), to move from cooler (blue) tones to warmer (yellow) tones and vice-versa.

To reset slider adjustments, double-click on the slider. For both RAW or RGB files, it is not always necessary to look for perfect white balance. Keep in mind the atmosphere of the scene you have photographed, and try to adjust the settings to maintain that atmosphere.
Tone & Color advanced adjustments

Tone

- Tone Curve

Color

- Color Accentuation
- HSL (Hue, Saturation, Lightness) system

Tone curve

The tone curve can be adjusted either channel by channel or globally

About the Tone Curve

The Tone Curve is a powerful but complex tool. We recommend practicing a bit before attempting to correct real photos. Note that many results obtained with the Tone Curve can also be obtained by using the HSL palette or DxO Smart Lighting and Selective tone in the Essential Tools palette.

The Tone Curve translates input tonal values (light received) to output tonal values (light seen in the image). The simplest case is one in which the tone curve is a straight line ascending at 45° from the origin, as in the illustration above. Such a tone curve is neutral: every input value of light, whether in dark, medium, or light tones, is translated exactly into the same output value. Input values (from 0, the darkest, to 255, the lightest) are on the x-axis, output values (similarly running from 0 to 255) are on the y-axis.

You can subtly change and redraw tone curves region by region, and even color by color, to suit a particular photo. Quite often this takes the
form of an “S-shaped curve” that compresses the dark shadows and the highlights, but expands the mid-tones. This can often result in a more contrasty, "punchy" — and ultimately more pleasing — image. But once again, playing with the tone curve is not a matter of set recipes; it is a complex matter that takes practice and experience.

**Modifying the Tone Curve**

You can adjust the slope of only the central part of the curve (the "gamma") by setting the slope value in the middle of the x-axis with the Gamma slider, set to 1 by default. Values can range from 0.05 to 6.00:

- Values above 1 increase the contrast and bring out details in shadow.
- Values below 1 reduce the contrast and bring out details in highlights.

Redraw the curve by defining and then moving points on the neutral curve (most often one point in the light shadows and one point in the lowest highlights, but more points are possible). Define points by clicking on the curve. (Active points are filled; inactive points are shown as white squares). You can drag an active point toward the top or the bottom to modify the curve.

An active point can be deleted by right-clicking or by moving the pointer over it and pressing Delete.

You can modify the black and white points on the x-axis and on the y-axis either by dragging them along their axis, or by entering the desired value in the adjacent boxes.

The drop-down menu at the top of the Tone Curve palette lets you apply the tone curve either to all three color channels (RGB) simultaneously, or channel by channel. Two reset buttons to the right let you revert to the default neutral curve (straight line at 45°) either channel by channel, or for all three channels at once.

---

**Color**

**Color accentuation**

The Color accentuation palette contains two sliders that enhance colors in very different ways: *Saturation* and *Vibrancy*.

**Vibrancy**

Compared to the Saturation slider, which reinforces all colors, the Vibrancy slider operates in a much more subtle way, taking into account the colors already present in the image. It can be defined as a "smart" color saturation setting. The range is from –100 to 100, and the default setting is 0. When the slider has a positive value, vibrancy increases the overall saturation, but with some very particular behaviors:

- Skin tones are protected to avoid red faces.
- Blue sky tone saturation is increased and slightly darkened than for the rest of the colors in the image, to give greater presence and depth to the sky.
- Tones already close to gray are not affected, to avoid a change of color balance.

When the slider has a negative value, the overall saturation level decreases, with the following restrictions:

- Desaturation never goes down to zero (i.e., a black and white image), unlike the most radical HSL corrections.
- Desaturation is more pronounced in the reds, which is useful for "rescuing" photos in which the faces are too red, and for making skin tones more natural.

**Saturation**

The Saturation slider is easy to understand: it increases the entire image color saturation if you move it to the right, and decreases it if you
move it to the left, ultimately converting the image to gray levels when you reach a value of −100. The default setting is 0.

**Beware of undesirable results if you combine a strong Vibrancy correction with an excessive level of Saturation.**

### HSL (Hue, Saturation, Lightness) system

Among the multiple systems used to describe the colored spaces, the HSL system is well-known for its effectiveness and simplicity. Each color has three parameters: its hue (H), its saturation (S), and its lightness (L). This correction is available for each of the six color channels in an image:

- **The additive colors (RGB: Red, Green, and Blue).**
- **The subtractive colors (CYM: Cyan, Yellow, and Magenta).**

**Hue**: The Hue slider modifies the tint of the selected channel. As an example, if you select the yellow channel, moving the slider to the left will progressively change all the yellows in the image to magenta, and if you move the slider to the right, the yellow will change into green. The slider has a range of values from −180° to +180° because hue is classically illustrated as a circle on which all colors are located.

**Saturation**: The Saturation slider determines how strong a color or a tint is. If we carry on with the yellow channel as an example, moving the slider to the left progressively removes the color until the yellows in the picture turn gray. On the other hand, moving the slider to the right reinforces the yellows, turning them into orange near the end of the range. The slider can be adjusted from −100 to +100.

**Lightness**: The action of the Lightness slider is easy to understand if you look at its effect on the Histogram. Moving the slider to the right shifts the black point to the right, compressing the tonal range into the upper half of the scale. Conversely, moving the slider to the left brings the white level down towards the black tones, compressing the tonal range into the lower half of the scale. In short, still using our example, moving to the left will make yellows darker and deeper; moving to the right will make them brighter and lighter.

**Reset**: The Reset button cancels all HSL corrections and resets all the sliders to their default value of 0.

If you want to correct several colors, we suggest you make note of the correction values you use for each color layer, so that you can fine-tune a particular correction without having to start over again: moving a color just a few points can have a significant effect!
Noise reduction & Sharpening

- **Noise reduction: High Quality (Fast)/PRIME/SuperRAW**
- **Unsharp Mask**

## Noise reduction: High Quality (Fast)/PRIME/SuperRAW

### Noise in digital photography

All digital cameras suffer from noise to a certain degree. Noise is characterized by grain (luminance noise) and random color pixels (color noise). Noise is much more of a problem in the shadows (where the luminance signal is low) than in highlights. Noise is aggravated at high sensitivities (high ISOs) that basically amplify the image signal and thus amplify the noise along with it.

![The Noise Reduction palette (Microsoft Windows)](image-url)
The Noise reduction palette contains two Quality buttons that correspond to two different levels of processing:

- **HQ (Fast)**, which corrects noise quickly and efficiently in the majority of situations.
- **PRIME (ELITE Edition) or SuperRAW**, which analyzes your image in depth in order to distinguish between details and noise, thus offering a highly superior quality of correction in which the details and color saturation are perfectly preserved.

**High Quality (Fast)** noise reduction can be applied to all JPEG, TIFF, RAW and DNG files supported by DxO PhotoLab. **PRIME** noise reduction cannot be used with JPEG, TIFF, and SuperRAW files, but can be applied only to RAW and DNG files. **SuperRAW** noise reduction can be used only with DxO ONE (see the Support for DxO ONE section in this user guide).

The higher the ISO sensitivity, the more visible the difference in processing quality. As a general rule, the difference starts becoming more and more pronounced from ISO 1600 and higher, although this can depend on the kind of camera you use for any given image.

You can also use PRIME for images taken at lower sensitivities with very dark areas in which considerable noise tends to be present. Traditional noise correction noise in shadows has an impact on color saturation, so here, too, PRIME can make a big difference.

**Processing preview**

Reducing noise in HQ mode takes place in real time on the screen, regardless of how your image is displayed (fit-to-screen, zoom, etc). This is not the case with DxO PRIME, which performs intensive calculations even when simply refreshing the display. However a thumbnail of PRIME-quality processing can be previewed in the Loupe window in the Noise reduction palette. This preview displays a selected ~260 x 150-pixel area of the image.

![Noise reduction - RAW](image)

When you choose PRIME, a barred-eye icon will appear next to the Noise Reduction palette name, indicating that the correction cannot be seen in the Viewer.

To select a particular area in your image to preview, click on Magnifier center near the upper right corner of the palette. This will activate the Magnifier by placing a dotted-line rectangle in the image in the Viewer. You can move this rectangle wherever you wish within the image. You will see a small circular icon in the Magnifier window until PRIME has finished processing the area you have selected.

The definitive application of the PRIME correction to the entire image occurs only upon export.

When an image is corrected with PRIME, a blue band with the letter P is displayed in the upper left of the corresponding thumbnail (Windows).

The **Luminance** slider attenuates the grain present in the image, notably the high-frequency noise that can interfere with the finest details.
Advanced settings

Clicking on the + in the lower right corner of the Noise Reduction palette also gives you access to the following advanced sliders:

- **Chrominance**: Reduces colored noise (speckles of unwanted color, such as yellow on flesh tones, or blue on grey tones) to which the eye is particularly sensitive.

- **Low freq. (RAW only)**: Corrects coarse ("low frequency") noise, such as pixel clusters that can affect skin rendering.

Unsharp Mask

About Unsharp Mask

The purpose of the Unsharp Mask tool is to sharpen an image. The tool makes a blurred copy of the original picture, then subtracts the original from the blurred copy, leaving the finest details, which can then be enhanced.

![The Unsharp Mask palette (Microsoft Windows)](image)

The Unsharp Mask palette includes the following four sliders:

- **Intensity** sets the amount of sharpening to be applied to the whole image.

- **Radius** sets the thickness of the edges to be sharpened.

- **Threshold** sets the level above which details will be sharpened, and below which they will be left as they are, making it possible to avoid sharpening the smallest details that look just like noise.

- **Edge offset** lets you homogenize the sharpness between the center and the edges of an image.

75% zoom is the minimum level for working with the Unsharp Mask palette corrections; however, we recommend that you always choose to work at at least 100% zoom to ensure accuracy and efficiency.

Using the Unsharp Mask

The Unsharp Mask correction is disabled by default. It is unnecessary for JPEG files, as in-camera processing has already sharpened them, and it is usually unnecessary for RAW images for which a DxO Module is available. This means its use is really confined to unsharpened JPEG files and RAW files without a DxO Optics Module. In the latter instance, we advise fine-tuning the Unsharp Mask settings, and then creating a preset.

We recommend that you try fine-tuning the three sliders using these starting values: Intensity = 100, Radius = 0.5, and Threshold = 4. For most images, Threshold should stay within a range from 4 to 10. Radius determines how subtle the correction is: excessive values will result in halos. Finally, you can set the Intensity slider up to 200.

The negative values in the Intensity slider (from −100 to 0) can be used to soften instead of sharpen an image (which can be useful for portraits).
Local adjustments & Details corrections

Local Adjustements Tools

- Introduction to local adjustments
- Accessing local adjustments
  - Radial menu
- Local adjustment masks
  - Local adjustment mask interface
  - Brush
  - Graduated filter
  - Control Point
  - Automatic mask
  - Eraser

Details corrections

- Repair Tool
- Red Eye

Introduction to local adjustments

DxO PhotoLab local adjustment technology takes your photo editing to the next level by letting you target specific parts of the image, either to highlight a detail or to perform precise touch-ups. Whether it’s to brighten the sky, bring out a backlit subject, or enhance the colors or sharpness of a specific detail, the possibilities are endless.

With DxO PhotoLab, you have a wide variety of local adjustment masks as well as a brush, a graduated filter, control points featuring control point technology, and an automatic mask that you can combine with different adjustment techniques in the same image.
Accessing local adjustments

Once you’ve used the right-hand palette tools to apply the corrections you want to the entire image, go to the Customize tab and click on the Local Adjustments button in the upper toolbar to apply local adjustments. Then right-click on the image to open the radial menu.

Radial menu

As its name implies, the radial menu is a circular palette that displays the different types of available local adjustment masks. Starting from the left and moving clockwise, these tools are arranged as follow:

- **Brush**: lets you apply adjustments by painting in the image.
- **Graduated Filter**: mimics the effect of optical graduated filters.
- **Control Points**: lets you apply U-Point technology to define an automatic mask based on one given pixel. Actually, it will let you define a pixel, and kind of tolerance area in which the program will look for similar color and brightness pixels to those nearest where you click.
- **Auto Mask**: lets you apply adjustments with a brush while automatically detecting the edges of the subject.
The radial menu also includes the following features:

- **Eraser**: corrects or deletes local adjustment masks.
- **Revert to Original / Reset (bottom of radial menu)**: removes all local adjustments with a single click.
- **New Mask**: creates a new local adjustment mask.
- **Help (center of radial menu)**: opens an information window on the bottom right-hand corner of the image when a tool is activated.

⚠ **Note:** The mask you select turns blue in the radial menu. You can activate only one mask at a time.

To open the radial menu, right-click anywhere in the image at any time. You cannot move the radial menu with the mouse, but you can display it wherever you want by right-clicking in the desired area.

If you open the radial menu while using a mask tool, you can go back to the active mask by hitting the Escape key on your keyboard. If you press the Escape key a second time, you will exit the local adjustment window.

### Local adjustment masks

A local adjustment is simply a touch-up or correction that you apply to a specific area or element in the image. The touch-ups are applied on top of any overall corrections, which you make using the preset option or the manual and automatic adjustments tools under the Customize tab.

When you use the Brush, Graduated Filter, Control points, or Automatic Mask, you create a mask over the part of the image you’d like to retouch, and then you use the Equalizer to make any adjustments to the mask. Except for the Control points, you can choose to highlight the retouched areas with a blue mask, which makes it easier to see the parts of the image you are editing.

### Local adjustment mask interface

Unlike the overall correction tools that are grouped within a palette and occupy a specific part of your screen, you can place the local adjustment mask interface anywhere in your image after clicking on the Local Adjustment button in the upper tool bar. Select your mask on the radial menu described above.

### Shared interface features

After you select a mask, the shared interface will include the following features:

- The mask, which is represented by a disk and the icon of the selected tool. The active mask disk is black with a blue border, while any inactive masks are grayed out.
- A floating help window in the bottom right-hand corner that displays a list of possible actions and keyboard shortcuts. The help window opens automatically; you can close it by clicking on the X button in its upper left-hand corner. To open it again, right-click on the image and then click on "?" in the center of the radial menu.
- The Equalizer, which includes correction tools that change the mask as you move their vertical sliders up and down.
- A toolbar located below the image (macOS only) with a range of options that change with each mask you select; a Revert to Original/Reset button to cancel active adjustments; and a Close button to exit the local adjustment mode.
Equalizer

The local adjustment settings appear in the equalizer in the form of vertical sliders. These corrections are (from left to right):

- **Exposure**: adjusts the luminosity elements within the mask. Move the slider up to lighten the image. Move the slider down to darken it.
- **Contrast**: adjusts contrast within the mask. Move the slider up for more contrast. Move it down for less contrast.
- **Micro-contrast**: increases or decreases the local contrast of micro-details (textures and other features). Move the slider up to emphasize elements within the mask. Move it down to blur the micro-details.
- **ClearView**: increase localized contrast and remove locally haze effect.
- **Vibrancy**: increases or reduces color saturation in a non-linear fashion. This feature enhances an image’s colors without changing any colors that are already saturated.
- **Saturation**: increase/decrease a color range intensity.
- **Warmth** (RAW files only): locally adjusts white balance. Moving the slider up increases the warmth of the image, while moving it down makes the image cooler.
- **Hue** (RAW files only): corrects color problems that are visible in the shadows after adjusting Warmth. Compensate with magenta by moving the slider up. Add green by moving the slider down.
- **Sharpness**: increases or reduces sharpness in the adjustment mask. To check the effect on your screen, zoom in to at least 75%.
- **Blur**: applies a blur effect. Move the slider up to increase the blur effect. Move it down to reduce the blur effect (the Blur slider does not move past the median line).

Note: The Warmth and Hue sliders take into account the image’s overall white balance. This is indicated by the blue buttons; the other buttons are shown in black. You can check the values (displayed in K for warmth and on a scale of –200 to +200 for hue) by hovering over the boxes.

When you make an adjustment, only the specific associated scale is displayed, and the Equalizer will be temporarily invisible. To adjust a setting:

- Click on the scale, then move the mouse vertically. The value increases when you move it up and decreases when you move it down. The settings level is indicated by a blue bar and a numerical value in a floating tile when you move the mouse.
- To make even more precise adjustments (Windows version only), click on the scale, then move the mouse horizontally. This will significantly slow down the application of the correction and its corresponding numerical display.

The horizontal line represents the setting’s median value. You can undo all Equalizer settings by clicking on the circular arrow to the right. To undo a specific setting, double click on the corresponding vertical bar.
Finally, if the Equalizer is obstructing your view of your adjustments, you can hide it with the E key. Unhide it by pressing the same key.

**Compare the image with and without local adjustments (macOS only)**

The Reference Image tool in DxO PhotoLab lets you compare the photo with and without local adjustments. This will show you the impact of the local adjustments on your image and help you decide whether you want to save, further adjust, or delete your changes.

To compare the image with and without local adjustments:

- Local Adjustments must be active.
- In the Display menu, go to Reference Image. In the contextual menu, check All Corrections Except Local Adjustments.
- Click and release the Compare button in the upper tool bar to see a version of the image with and without local adjustments.

To deactivate the comparison, go back to Reference Image, then uncheck All Corrections Except Local Adjustments.

**Note:** The All Corrections Except Local Adjustments option is available only in the macOS version.

**Brush**

**When to use the brush**

The brush is a mask that lets you retouch parts of the image by simply painting with your mouse pointer or any other system you wish to use, such as a tactile surface or trackpad.

This universal tool lets you perform a range of tasks, including lightening a backlit subject, enhancing the color of a single flower, or increasing the sharpness of a subject’s eye. The applications are endless, especially since the brush lets you paint continuously (e.g., lightening an entire silhouette) or subject by subject (e.g., highlighting both eyes of your subject, one eye at a time). You can also create several brush masks in the image.
Activating the Brush

Click on the Local Adjustments button in the upper toolbar, right-click in the image to display the radial menu, and select the brush tool.

Using the Brush

The brush tool appears as a blue disk with a brush icon. Click on the part of the image you want to retouch. The active disk for the mask and Equalizer will appear. At this point, you can continue to paint and apply adjustments afterwards, or first make your adjustments and then paint in the image. Of course, you can use multiple adjustment tools from the Equalizer on the same part of the image. For example, you can lighten an object and also increase its sharpness and micro-contrast.

- You can change the size of the brush using the mouse wheel while holding down the Ctrl (PC) or Cmd (Mac) key. Scroll up to increase the brush size, and down to decrease it.
- To adjust the amount of feathering or sharpness along the brush edge, use the mouse wheel while holding down the Shift key. Scroll up for a crisper, more defined edge, and down for a softer focus effect.
- Opacity lets you determine the maximum level of opacity (or transparency) of the area you’re painting. If you set the opacity at 100%, your adjustments will be applied at 100%, and the area will be completely opaque, or covered up. If you set the opacity at 50%, the brush will cap this setting at 50%, and your local adjustments will be only 50% applied, which will allow the original area content to remain partly visible.
- Flow lets you determine the amount of “paint” you apply with each stroke of the brush. If you set the flow to 100%, a single brushstroke will reach the maximum opacity setting selected. If you set the flow to 13%, the first brushstroke will apply 13% of maximum opacity. A second stroke over the same area will add another 13% of the maximum value, and so on until the maximum opacity level is reached.

Windows:

Mac:
When you use the brush, a blue mask will appear where you've applied the tool to help guide you as you retouch the image. Zoom in for more precision or to paint along an edge. When you are not painting, you can activate or deactivate the blue mask display by clicking on the Display Selected Mask checkbox in the toolbar below the image (macOS only).

**Creating and managing masks**

You can create as many masks as you want to retouch specific subjects or to paint separate parts of an image. You can also layer your corrections.

**To create a new brush mask,** unselect your current mask by clicking inside the circle. Then place the blue disk with the plus sign wherever you want and click to create a new brush active mask.

*Note:* You cannot move a brush mask in the image. To paint another area in the image, create a new mask by unselecting/deactivating your current mask.

**If you want to delete a mask,** activate it, then press the Enter key (macOS) or the Delete key (Windows).

**Erasing**

If you paint over an edge or want to correct an error, activate the Eraser by holding down the Alt key (PC) or the Option key (Mac), then go back to your active mask. Use the blue mask to see where you want to erase. You can also adjust the size and feathering. To return to Brush mode, let go of the Alt or Option key. [More information on the Eraser.]

**Graduated Filter**

**When to use the Graduated Filter**

The graduated filter simulates the effect of optical graduated filters that are fitted in front of lenses. They are especially useful for balancing the exposure of landscape photos and reducing the extreme contrast between a brightly-lit sky and dark ground.

![Graduated Filter example](image)

**Activating the Graduated Filter**

Click on the Local Adjustments button in the upper toolbar, right-click in the image to display the radial menu, and click on the Graduated Filter icon.

**Applying the Graduated Filter.**

Once you've activated the graduated filter, the mouse pointer changes to a cross (macOS) or to a gradient icon (Windows). Position it at the top of the image, then move the mouse down. The graduated filter includes the following elements:
A solid line, with the mask disk corresponding to the starting point of the graduated filter.

A central dotted line with a point indicating the center of the mask.

A transparent mask with a blue gradient that indicates how the mask is applied and how it spreads. The effect starts off at its most intense then gradually fades as it moves toward the dotted line.

To apply corrections, use the sliders on the Equalizer. You can layer several graduated filters in the same area with a new adjustment each time. (A simpler solution is to combine several corrections in the same graduated filter.)

Managing the Graduated Filter

You can move the graduated filter anywhere in the image. You can even tilt it by clicking on the gray point along the dotted line.

You can move the dotted line in two directions to either extend or reduce the area with the most intense effect. You can also move the starting line in either direction to adjust the area where the effect fades.

Notes:

- You can apply the graduated filter from any direction—starting from the top, the bottom, sides, or corners.
- You can apply several graduated filters to the image.
- If you move or edit a graduated filter mask, the corrections are shown in real time.

If you want to delete a graduated filter, activate it by clicking on the mask disk, then press the Enter key (macOS) or the Delete key (Windows).
Limiting the graduated filter effect in part of the image
When you apply a graduated filter to an image, such as to darken or enhance the sky, you normally won't want to apply the effect to the features on the bottom half of the image (such as buildings, statues, and ground relief). Use the Eraser to remove the graduated filter effect from these elements.
Once you've finished with the eraser, go back to the active graduated filter by right-clicking in the image, then clicking on Graduated Filter in the radial menu.

Control points

DxO PhotoLab's Control points tool works in a very specific way. When you click in the image to create a control point, the tool analyzes the luminosity, contrast, and color of the pixels at that point and then applies the correction to all pixels with the same characteristics within an area you define.

For example, if you place a control point on a red cup with a contrasting background and adjust the area so it includes the cup, the corrections will be applied only to the cup and not to the background. If the image contains another red object and you don't include it in the defined area, the second object will remain unchanged. However, if you include it within the defined area, it will be affected by the same changes that are applied to the red cup. If you apply another control point mask to the object, any adjustments you make will not affect the first control point mask.

Activating Control points

As with the other local adjustment tools, first click on the Local Adjustments button in the upper toolbar, then right-click in the image to display the radial menu. Click on the Control Point icon. (If you are already working with local adjustment tools, right-click in the image to display the radial menu, then select Control Point.)
You can apply as many control point masks as you want. You can also use them in an image that already has other types of local adjustment masks.
Using Control points

After you activate a control point mask, the mouse pointer changes to crosshairs when you roll over the image. Click inside an area or on a part of the image that you want to correct. The control point mask is represented by a disk with a plus sign in the middle and a larger surrounding circle. As with the other tools, the blue border indicates an active mask. Control points can be interconnected, allowing you to apply the same correction to several places in the image. To do this, activate the control point mask and click inside the image as many times as you want. Secondary control points are represented by a simple crosshair icon and a circle indicating the area where changes will be applied (you can adjust the size for each secondary control point separately). Apply the desired adjustment using the Equalizer.

The effect will be applied to all control point masks belonging to the same mask — that is, to the first control point and to all its secondary control points.

You'll need to create a new control point mask each time you want to apply a different adjustment.

Adjust the area covered by the control points by clicking on the outside circle with the mouse and then using the Equalizer to apply the settings you want.

Managing Control points

Click on the central disk to move a control point to wherever you want.
Automatic Mask

The automatic mask tool lets you paint and apply adjustments in specific areas of the image without going beyond any edges, which are defined by a difference in luminosity, contrast, and color. Except for the tool’s automatic edge-detection capabilities, you use it in the same way as the brush. Even if you go beyond the edge with the mouse, the adjustment will be applied only inside the edge.

When to use the Automated Mask

The automatic mask is especially effective on specific objects or elements. For example, you can use this tool to change the color of a vehicle to make it stand out from the surrounding environment. To change the appearance of more diffuse or larger image elements, such as the sky, use control points or the graduated filter tool.

Activating the Automatic Mask

Click on the Local Adjustments button in the upper tool bar, right-click inside the image, then click on the Auto Mask feature in the radial menu. You can use the automatic mask on an image that already has other local adjustment masks.

Using the Automatic Mask

Once activated, the automatic mask tool will turn into a brush with a blue circle and a plus sign in the middle. Click inside the image to place the mask disk containing a brush with a blue "A" label. The blue border indicates that it is an active mask.

Paint inside the area or the element that you want to retouch. You can apply adjustments using the Equalizer before or after you paint. You can also apply brush strokes by clicking several times. Even if you click outside of an element in the image, the correction will generally not go beyond the edge. However, if the correction does go beyond the edge (which can occur if certain parts of the element you are retouching blend into the background), use the keyboard shortcut Alt (PC) or Option (Mac) to activate the Eraser.

If the element is textured, the coverage will not be perfect—just use the brush again a second time.
You can adjust the size of the brush using the mouse wheel while holding down the Control (PC) or Cmd (Mac) key. To view the active mask, check Display Selected Mask in the toolbar below the image.

**Note:** You cannot use the automatic mask brush to apply a feathered effect.

Managing Automatic Masks
To delete an automatic mask, activate it by clicking on the disk and then pressing the Enter key. If you need to create another automatic mask, unselect the active mask by clicking in the disk, and then click in the image where you want to create a new mask.

**Note:** As with the brush tool, you cannot move an automatic mask in the image

**Eraser**

The eraser lets you refine your local adjustments and correct any errors — for example, if you go beyond the edges of an object with the brush or the automatic mask. You can also delete or add adjustments depending on the type of mask you’ve selected.
Activating the Eraser

There are two ways to activate the eraser:

- Select the eraser from the radial menu.
- Press the Alt key (PC) or the Option key (Mac) when using the brush or the automatic mask.

In the first case, the mouse pointer turns into an eraser. To change its size, use the mouse wheel while holding down Control (PC) or Cmd (Mac). Hold down the Shift key and use the mouse wheel to change the feathering effect. You can also use the sliders in the toolbar below the image.

Using the Eraser

Select a mask by clicking on its disk. To better see where to apply the eraser, activate the blue mask by checking Display Selected Mask in the toolbar below the image.

Apply the eraser to the local adjustments you want to edit or redo. If you erase an adjustment by mistake, temporarily switch to addition mode by clicking while holding down the Alt key (PC) or Option key (Mac). This will allow you to restore the adjustment. If you want to edit it, you can change the settings in the Equalizer.

To erase something in a different mask, deactivate the active mask (click inside the disk), then activate the other mask (click in the disk to turn the edge blue).

Reminder: You can always access the eraser along with the brush and automatic mask by pressing the Alt key (PC) or Option key (Mac).

Details corrections

Repair tool

This tool lets you eliminate spots, dust, and other small undesirable elements, by "painting" over them with a line or point (of adjustable thickness or diameter).

After you click on the Repair tool button in the upper command bar or in the Repair sub-palette, all you need to do is to zoom in on the image (or press the Space bar to temporarily activate the Hand tool) to navigate in the image to look for dust specks, and to set the size of the Brush width slider (up to 200 pixels) located under the Viewer, or by using the Ctrl/Cmd key + your mousewheel. Then simply click on a dust speck, or trace a line by holding down the mouse button. The corrections are visible any level of image enlargement.

You may see slight differences in the strength of the correction depending on what level of zoom you are at. Use zoom at 100% to
see what the correction results will actually look like when the image is processed and exported.

To cancel a correction, make sure that the **See masks (Mac) / Show masks (Windows)** option is checked in the lower toolbar, and then hold down the Delete key. A cyan circle or line indicates an active correction, and a pink circle or line indicates an inactive or unselected correction. To eliminate all of the dust corrections on an image, click on **Reset** under the images and below the Viewer.

If a spot appears on several images in a row, correct the first one in the series, and then create a preset so that you can correct the entire batch. You can also copy and paste the correction settings.

### Red Eye

Correcting red eye is entirely automatic, with a manual mode available in case there is difficulty with detection. The tool can be used with RAW and DNG files, as well as with JPEG and TIFF.

![Red Eye palette](image)

To activate the automatic correction, click on the Red Eye button, either in the upper command bar, or in the **Red Eye** sub-palette in the **Detail** palette. The correction is automatically applied within the selection ellipses for each red eye detected in the image. The sub-palette indicates the number of red eyes detected.

Moving the mouse over the ellipses lets you activate them in order to perform the following operations:

- Moving the ellipse.
- Changing the size of the ellipse either horizontally or vertically, using one of the two handles.
- Rotating the ellipse by using one of the two handles.
- Deleting by clicking the cross just outside the upper right of the ellipse.
In case any red eyes are not detected (confirmed by the message “No red eyes detected” in the sub-palette) — either because they are in profile or they are too small — you can perform the corrections manually as follows:

1. Activate the Red Eye tool in the command bar or in the sub-palette.
2. Draw a selection rectangle around an eye. The correction will be applied automatically (confirmed when the rectangle changes to an ellipse).
3. Adjust as needed (position, size, orientation of the ellipse).
4. Go to the next undetected eye and repeat steps 2-4.

The toolbar underneath the image lets you activate or deactivate the display of the ellipses (also known as the “pupil area”); to reset the corrections; and to close the tool.
Fine tune Lens corrections & Geometry

- **DxO Lens Sharpness**
- **Chromatic aberrations**
- **Moiré (ELITE Edition)**
- **Focal length and focusing distance**
- **Crop**
- **Distorsion**
- **DxO ViewPoint**

DxO Lens Sharpness

About lens sharpness

DxO PhotoLab's exclusive DxO Lens Sharpness tool is one of its major strengths. Lens sharpness is an optical aberration which results in a point being transformed by the lens into a small blurred circle. (This should not be confused with out-of-focus or motion blur, which DxO PhotoLab does not correct.) DxO Optics Modules have been created by measuring the amount of blur for every point in the image area for each supported camera body and lens combination. By combining the shooting parameters saved in the EXIF metadata (aperture, focal length, etc.) and the information provided by the Optics Module, DxO PhotoLab can apply corrections that are tailored to each pixel in the image. These corrections are not uniform, given that lenses are sharper in the center, which means that the pixels closer to the edges of the image will be subjected to a stronger correction than those near the center.

The Lens Sharpness palette is visible only for images for which the appropriate DxO Optics Module is loaded. If no module is available, you should use the Edge offset slider in the Unsharp Mask palette (in the Detail and Geometry – Advanced palette) to manually adjust the sharpness in image corners.

- **Global**: DxO has defined 0 as the default setting for the Global slider, whose range goes from −3 to +3. The negative settings (from −3 to 0) do not diminish the image sharpness, but result in more subtle corrections; in any case, the corrected image will be at least as sharp as the original. Even set at 0, the sharpness is greater than that of the original. To diminish the sharpness (as with a portrait, for example), set the Global slider to the left, and to increase the sharpness, go to the right. The Lens Sharpness tool is what is known as an “intelligent” correction — one that is able to confine its effects to the noisy parts of the image, or when a photo was taken at high ISO.

It is important not to increase the sharpness of a shot that has already been sharpened by the camera, as is the case for JPEG images. So if you intend to post-process your images, you should shoot without any in-camera sharpening.

- **Details**: The Details slider is set at 50 by default and is used to enhance the micro-contrast of fine details in the image. This subtle correction can be very worthwhile for use in landscapes, but should be reduced to a minimum for portraits, where a certain degree of sharpness is needed to hide (for example) skin blemishes.

Unlike the Unsharp Mask tool, enhancing details with the DxO Lens Sharpness tool does not create white edges or halos around the
- **Bokeh**: The Bokeh slider reduces artifacts in the bokeh (i.e., the out-of-focus area in your photos, mostly in the background) that can appear when using the sharpening tools. However, reducing those artifacts will slightly reduce the sharpness of the in-focus areas of your image.

**DxO Lens Sharpness and Unsharp Mask**

We recommend that you perform as much of your sharpening as possible using the DxO Lens Sharpness correction tool before using the Unsharp Mask. Of course, for images where the appropriate DxO Optics Module is not installed, you will have to use the Unsharp Mask for all manual sharpening tasks.

---

**Chromatic aberrations**

**About chromatic aberrations**

Chromatic aberration results from different colors focusing at slightly different places, and leads to defects which can be easily seen at the edge between two contrasting areas: green and red halos (so-called lateral CA), and/or purple-only or green-only halos (longitudinal AC). A particular phenomenon that is also mostly due to chromatic aberration, "purple fringing" is when a ghost-like purple image appears along highly-contrasted edges.

![Example of chromatic aberrations](Image)

*For most images, the need to correct chromatic aberrations and purple fringing is unavoidable*

**Correcting chromatic aberrations**

Lateral chromatic aberration (e.g., magenta or green fringes along edges) is automatically corrected only if the appropriate DxO Optics Module is available. In this case, no further manual action is necessary.
The Chromatic Aberrations palette

You can correct the other types of chromatic aberrations (longitudinal or other) using the two sliders in their respective sections of the palette:

- **Intensity** sets the strength of the correction, within a range of 0 to 200.
- **Size** adjusts the width of the colored fringe to be suppressed, within a range from 0 to 12 in arbitrary units. This setting affects how DxO PhotoLab determines the chromatic aberration to be corrected, and what is real image content.

You should check the **Purple fringing** correction box for all backlit scenes, or when shooting with a lens prone to this optical defect.

Moiré (ELITE Edition)

Moiré appears as colored artifacts or patterns when fine, high-frequency details interfere with the camera sensor. This is particularly true for cameras with weak or no low-pass filters. The photos they produce are sharper than those taken with traditional digital cameras (which use strong bypass filters), but the risk of introducing moiré will be much higher. Moiré is especially apparent in image details such as tile roofs, wire fences, mesh, feathers, fur, hair, and fabrics.

![Moiré palette](image)

**The Moiré palette**

The **Intensity** slider helps to reduce or recover these artifacts. Its range goes from 0 to 100, with 99 as the default value in auto mode. After any adjustments, you can reset to the default value by clicking on the magic wand.

> The effect of this tool can only be previewed if your image is displayed at 75% zoom or higher.

Focal length and focusing distance

The lens focal length and focusing distance of a photo are recorded in the EXIF data of your images. However, this information is not always accurate. For example, different but close positions of the focal length ring (say, 17 and 18 mm) could result in the same value (say 18 mm) being recorded in the EXIF data. In this case, the distortion correction may be less than optimal. In the same manner, the focusing distance might be recorded in the EXIF data with insufficient precision, and similarly lead to an imprecise correction. In both cases, to improve the effectiveness of the optical corrections, you can provide more accurate values in one (or both) of the rollups that appear in the Geometry palette:

- **Focal length**: Use the slider to specify the lens focal length.
- **Focusing distance**: Select a range for the focusing distance in the drop-down menu, then fine-tune with the slider.

> The Focal Distance and Distance focusing sliders are permanently displayed in the OS X version, and appear automatically in the Microsoft Windows version.
Crop

**Automatic cropping**

An image whose perspective has been corrected by the Horizon/Perspective tools generally loses some information at the edges – a great deal more if the correction is significant. This is why the Crop palette is set to **Auto based on Perspective / Horizon** by default, and the aspect ratio is set to **Preserve aspect ratio**, meaning that cropping is performed automatically on the corrected image, retaining as much information as possible.

Selecting **Preserve aspect ratio** in the Aspect Ratio drop-down menu instead of Unconstrained will resize your image while maintaining its proportions (i.e. the relationship between its longer and shorter sides: for example 3:2 or 4:3).

It is also possible to choose a different ratio in the **Aspect ratio** drop-down menu, such as 1:1 (a square format), 5:4 (replicating the traditional 5×4 or 10×8 format), or any other in the list. You can also type a ratio (2 figures separated by a colon) directly in the menu bar.

**The grid display is activated by default.**

**During cropping, you can zoom in and navigate within the image by using Move/Zoom palette.**

**Manual cropping**

If you click on the Crop tool button, a dotted-line crop box will display on the image. You can move or extend this box by dragging its corners. If you have chosen a specific aspect ratio, the box will display the proportions of this aspect ratio, and you will be allowed to change only one of its dimensions, the other tracking automatically. If you have chosen an unconstrained aspect ratio, you will be able to freely change both dimensions of the box.

To adjust a crop, you can also click on the Crop tool button. Once Crop has been enabled, select a point in the image, hold down the left mouse button and drag to create a crop box: it will appear as a black rectangular frame within the image.

Clicking on and dragging the corners of the box adjusts its size. Clicking inside the box lets you move it around.

Clicking outside the box removes the box and lets you create a new box from scratch.

In OS X, if you have selected Unconstrained in the Aspect Ratio drop-down menu, holding down the Shift key will allow you to preserve the proportions. Conversely, if you have chosen Original (which preserves the proportions), holding down the Shift key will let you move into Unconstrained mode.

When the crop tool is active, a command bar is displayed below the Viewer pane. From there, you can select a predefined aspect ratio, type in your own values, show or hide the grid overlay, reset and close the tool.

When you manually crop, the dimensions in pixels are displayed in the lower-right corner of the frame. You can choose a predefined aspect ratio for your image, or enter a custom ratio, display or hide the “rule of thirds” grid, reset the crop, or close the tool.

You can apply the settings and close the tool by pressing the Enter key, or reset the crop and close the tool by pressing the Escape key.
Distortion

The two principal types of distortion: pincushion (left) and barrel (right)

About distortion correction

The geometric distortion introduced by a lens may be in pincushion or barrel form – or sometimes even a mixture of the two. In each case, DxO Labs’ analytical measurements make it possible to correct the distortion such that straight lines in the original scene are correctly reproduced as straight lines in the photo.

The Distortion palette

The \textit{Intensity} slider controls the degree of the correction, with a range from 0 to 100%. The default setting is 100%, and you should only depart from this either to avoid the cropping of important details near edges, or for creative reasons.

The \textit{Correction} drop down menu allows you to select either automatic correction based on a DxO Optics Module, or manual correction. Only the manual option will be active if a DxO Optics Module is not available.

Automatic distortion correction

Provided the appropriate DxO Optics Module is loaded on your computer for the image you are working on, DxO PhotoLab will automatically correct any distortions.

Manual distortion correction

Select Manual in the drop-down menu if the relevant DxO Optics Module for your camera/lens combination is not available, or not loaded on your computer, or for creative reasons. In any case, first select the type of distortion you want to correct: Barrel, Pincushion, or Fisheye (for fisheye lenses).

\textbf{Use the grid to help you manually correct distortion.}

Changing a fisheye lens into a super-wide-angle lens

You can automatically turn your fisheye shots into ultra-wide-angle-style photos without circular distortion if the camera/fisheye lens combination is supported by a DxO Optics Module. You can also manually correct this distortion by using the \textit{Intensity} slider after choosing the Fisheye option in the Distortion type drop-down menu.
If you use the Fisheye correction tool, you can uncheck Keep aspect ratio so as to recover a non-negligible quantity of the angle of view.

Maintaining the aspect ratio
Most of the time the distortion correction changes the aspect ratio (i.e., the ratio between width and height) of the image. Since the aspect ratio is of great importance, especially if the photo is to be published, it is maintained by default, resulting in some cut-off (cropped) parts along the image edges. If you want to make sure that the entire usable part of the image stays visible, uncheck the Keep aspect ratio box at the bottom of the palette.

DxO ViewPoint

About the DxO ViewPoint palette

This palette is displayed only if a DxO ViewPoint plugin license has been activated.

DxO ViewPoint improves upon the old Perspective and Volume deformation tools in DxO PhotoLab, with the increased advantage of offering a more enjoyable interface. DxO ViewPoint 3 adds automatic correction of perspective and horizon, as well as a miniature effect.

Fixing perspective problems
In architecture, the photographer's position with respect to a building makes it impossible to shoot it face-on. In such cases, the object will look deformed because of divergent lines that are more pronounced the closer they are to the edges of the image. The DxO ViewPoint palette offers the following corrections:

- **Auto (DxO ViewPoint 3):** Automatic correction of vertical, horizontal, or vertical-and-horizontal perspectives.
- **Vertical** and **horizontal** parallels
- **Force a rectangle** (simultaneous and independent correction of four sides)
**8-point mode** (completely independent correction of four sides)

Complete and Natural modes: these buttons set the intensity of the corrections: 100% for Complete mode, and for a more realistic rendering of perspective and viewpoint, 75% for Natural natural mode. The values can be manually adjusted by using the Intensity slider.

As a means of simplifying the interface, the Complete and Natural buttons no longer appear in DxO ViewPoint 3. You can easily adjust the intensity of the correction by using the Intensity slider.

The 8-point correction mode is accessible only if you have a license for DxO ViewPoint 2 or 3, or if you are within the 31-day period when using the trial version of DxO ViewPoint 2 or 3.

If you corrected perspective in Auto mode, the automatic corrections are maintained if you choose to go into manual mode to further adjust or fine-tune them.

**Correcting volume deformation**

The deformation of subjects situated on the edges of images is a geometric flaw that is frequently seen in interior, event, and wedding photos. Known as volume deformation, it frequently occurs when using a wide-angle or wide-angle zoom lens to photograph objects, people, or groups of people. The elements on the edges appear elongated or stretched out. The DxO ViewPoint palette lets you correct this phenomenon as well as horizontal/vertical and diagonal distortion.

For more information about the different tools available depending on the version, see the DxO ViewPoint user guide.

**Miniature effect (DxO ViewPoint 3)**

The miniature effect simulates a tilt-shift lens that moves the plane of sharpness in an image, lending it the appearance of a scale model or of a diorama in a landscape photo. This effect is even more dramatic in images of urban landscapes when shot from above. The Miniature Effect tool provides great flexibility in the positioning and intensity of the focus areas.

When you activate the Miniature Effect, two gradients of blur appear on the screen (you will see 4 superimposed on the image): the solid lines delineate the area of the image that will remain sharp (generally in the center), and the dotted lines mark the transition zone between sharp and blurry at the top and bottom of the image. You can reposition the miniature effect anywhere in the photo, and you can also rotate it up to 360°.

The intensity of the shape and the blur are adjustable, and you can also deactivate the symmetry between the positions of the two blur gradients, as well as the intensity of the blur symmetry (meaning that you can have a different blur for each gradient).
Features specific to using DxO ViewPoint in DxO PhotoLab

A certain number of tools and features are specific to using DxO ViewPoint in plugin mode:

- The parts of the background that are cropped out after geometric correction are displayed in gray.

- It is possible to preview the correction directly by clicking on the image while holding down the Ctrl (Microsoft Windows) or Cmd (OS X) key.

- You can zoom in and navigate within the image using the toolbar. After zooming, you can also temporarily activate the Hand tool to move about in the image by holding down the Space bar.

- The anchor points for the perspective and horizon tools do not have an integrated magnifying glass.

- The Miniature Effect tool does not let you adjust the blur intensity interactively in the image the way it does in DxO ViewPoint 3. To adjust the intensity, use the Blur sliders in the Miniature Effect sub-palette.

- There is a Miniature Effect tool activation button in the upper command bar.
Advanced image effects

Tone

- Vignetting

Color

- Color rendering (DxO FilmPack not activated) - ELITE Edition
- Style – Toning (DxO FilmPack not activated)

DxO FilmPack

- About the DxO FilmPack palette

Tone

Vignetting

The appearance of the two Vignetting sliders when a DxO Optics Module is available

Vignetting is an optical aberration that results in corners and edges that are darker than the center of an image. The vignetting correction works differently and uses different commands depending on whether or not the relevant DxO Optics Module is available.

**DxO Optics Module available**

When a DxO Optics Module is available, the Correction drop-down menu will display Auto with DxO Optics Module, and the correction will be automatic. From there, if you want, you can either fine-tune the automatic correction, or use the Correction drop-down to switch to Manual mode.

The vignetting correction actually takes place in two steps, both of which can be fine-tuned:

1. First, from the lens data, focal length, and aperture setting, the DxO Optics Module calculates the necessary correction for every pixel in the image. The Intensity slider allows you to decide how much vignetting should be removed (within a range of 0 to 100%).

2. Second, a filter is applied to avoid clipping in bright areas and increased noise in dark areas. You can use the Preservation slider to set the intensity of this filter (from 0 to 100%), as follows:
   - If set to 0%, the vignetting correction will be applied without any restrictions.
   - If set to 80%, for example, the largest highlights and shadows will remain uncorrected.

When adjusting these two combined settings, we suggest sticking to the default 100% for the first Intensity slider, since the Middle slider is usually more effective in preventing undesirable vignetting correction side effects. Only vignetting due to the lens or sensor is corrected. Mechanical vignetting caused by a lens shade, for example, cannot be corrected. In the case of mechanical vignetting, you may want to use
the Crop tool to remove the unwanted parts of your picture.

As with many other DxO PhotoLab corrections, the magic wand allows you to revert to the default settings.

No DxO Optics Module available
If there is no DxO Optics Module available, the manual correction mode will allow you to adjust the degree to which the corners of the image need to be lighter. You can use the Middle slider to adjust how far towards the center of the image the correction will be applied.

Color

Color rendering (DxO FilmPack not activated) - ELITE Edition

Every camera, every processing software, and for traditional photography, every film, has a particular color rendering (and some renderings have contributed positively to their manufacturers’ reputations). The purpose of the Color rendering palette is to simulate the rendering of a camera X or a film Y. Beside aesthetic considerations, another use of the correction is linked to practical needs: many photographers who work with two or three different cameras want all of their image renderings to match. And professionals might also want also to deliver to their customers a neutral set of images that bears no noticeable signature of any particular camera.

![The Color rendering palette](image)

TIFF or JPEG images
As with several other corrections, Color rendering is inherently limited when applied to TIFF or JPEG images: the images have already been processed to some degree, and thus there is no access to the original file data. So for these formats, only certain film emulations are available.

You can access film options by combining certain choices found in the two drop-down menus, Category and Rendering (see below). The Intensity slider allows progressive changing of the original image into the selected emulation. The default setting is 100, with 0 for the original image, and all values above 100 “hyper-correcting” the image.

RAW images
Because RAW images still contain all the luminance information and have never been converted into any color space, they are particularly suitable for the Color rendering correction. This means that many creative opportunities are open to you, as you can see from the contents of the two drop-down menus Category and Rendering:

- **Generic renderings**: Camera Body is the camera default rendering: if you select a JPEG file, the rendering will match the manufacturer’s. In the second dropdown menu, you have the choice between four “neutral color” settings, which differ slightly only in the shape of their tone curves (i.e., contrast levels). Of these, the Neutral color, neutral tonality setting is our baseline for switching from any color rendering to another.

- **Camera body**: When selected, this option reveals (in the second drop-down menu) a long list of cameras of different makes and

DxO PhotoLab does not take into account the photo styles provided by some camera makers. However, it will try to match the standard original rendering as closely as possible.
models which DxO Labs has tested and measured, and whose color renderings you can use.

**Color Positive Films**: Without the DxO FilmPack plugin, DxO PhotoLab offers by default one single choice, Color-positive films, a selection of generic positive films.

---

**If DxO FilmPack is not installed and activated on your computer, the available analog film simulations will be limited to a very small list of well-known positive color films (Kodachrome, Fuji Velvia, etc.). However, if DxO FilmPack is activated, you can take advantage of more than 60 different film types (for more information, see the DxO FilmPack user guide).**

---

**ICC Profile**: Choosing ICC Profile opens a dialog box for browsing your file system to find color profiles that you might want to use. Remember that an ICC profile is a set of data that characterizes any visual device such as a camera, a screen, a scanner, etc. As with JPEG or TIFF images, an intensity slider allows a progressive change of the image’s original color space into another. At 0, only the original image appears; 100 is the default setting; and above 100, the image is “hyper-corrected.”

**Protect saturated colors**: The Protect saturated colors correction prevents some specific saturated colors from being clipped, which may lead to unnatural colors and loss of texture when a particular color channel is close to the minimum or to the maximum luminance intensity (0 or 255). This process is performed automatically; you can fine-tune or modify the result with the Intensity slider. Clicking on the magic wand restores the image to the original automatic setting.

---

**Style – Toning (DxO FilmPack not activated)**

The Style – Toning palette contains four presets which influence the overall contrast and saturation of the selected photos by reproducing four classic styles:

- **B&W**: Black and white conversion of a color image, based on its contents.
- **Landscape**: Greens are enhanced.
- **Portrait**: Puts the emphasis on skin tones.
- **Sepia**.

You can adjust the effects with the Intensity slider. The default value is 100, and 0 corresponds to the original image.

---

**The contents of the Style – Toning palette depends on whether or not DxO FilmPack has been activated. For more information, see section 3.5.6 on DxO FilmPack below.**
DxO FilmPack

About the DxO FilmPack

This palette is displayed if a DxO FilmPack plugin license has been activated.

The DxO FilmPack palette integrates the film emulations and editing tools specific to DxO FilmPack with your usual workflow in DxO PhotoLab.

The DxO FilmPack palette

Several palettes are at your disposal:

- **Color rendering**: This palette is a duplicate of the Color rendering palette found in the Color palette. It lets you simulate the color rendering of a given camera, an ICC profile, or any of a vast choice of analog films (black & white, color negative, etc.).

- **Style - Toning**: Duplicates the Style - Toning palette in the Color palette. It allows you to apply a number of tonings.

- **Filter**: Simulates lens filters.

- **DxO FilmPack Grain (Windows) / Grain (OS X)**: Lets you apply a specific grain type from more than sixty films, color as well as B&W, and to set the size of the grain.

- **Contrast**: Lets you adjust the contrast and the microcontrast of your images.

- **Channel mixer for black and white (Windows) / Channel mixer (OS X)** (available only in the ELITE Edition of DxO FilmPack): Lets you set and refine black & white conversion according to your taste by acting on the additive colors (RGB: red, green, and blue) as well as on the subtractive colors (CMY: cyan, magenta, and yellow).

- **Creative vignetting** (available only in the ELITE Edition of DxO FilmPack): With this palette, you can modify the amount of light on the edges of an image in order to draw attention to a subject in the center.

- **Blur** (available only in the ELITE Edition of DxO FilmPack): With this palette, you can create a blurry effect around your subject with Vignetting, and with Soft Focus, you can apply a diffusion effect to your images.

- **Frame** (available only in the ELITE Edition of DxO FilmPack): Lets you place a frame around your image; different styles are available.

- **Texture** (available only in the ELITE Edition of DxO FilmPack): Allows you to simulate scratches or tears on analog film negatives.

- **Light leak** (available only in the ELITE Edition of DxO FilmPack): Lets you reproduce the effects of aging analog film negatives or...
problems related to accidental exposure of analog film to light.

For more information about the different tools available depending on the version and/or the edition, see the DxO FilmPack user guide.
Support for DxO ONE

Starting with version 10.5, DxO PhotoLab supports DxO ONE files, which offer a certain number of dedicated tools, notably those for reducing noise in SuperRAW files; the possibility of changing the scene mode; the ability to take into account digital zoom - and along with that, the possibility of returning to the framing of the original shot.

You can correct your DxO ONE images in the same way as you do RAW files taken with your DSLR. You can use any of the tools in the Customize tab without restriction, and of course you can export, print, or transfer your images to other applications.

Manage images (Organize tab)

You can directly access your DxO ONE images via the DxO Connect application by clicking on Open in DxO PhotoLab:

Windows version

A session will be created automatically in the External Selections section in the Source Browser. Each session shows the date and time in the same format as the operating system.

In the Windows version, DxO ONE sessions cannot be renamed or deleted.

Mac OS X version

A project will be automatically created and added to the list of projects in the Source Browser. Each project is named after the session date. You can also go into the Source Browser to retrieve the images in the import folder, as defined in the DxO Connect settings.

In the Mac version, DxO ONE projects can be renamed or deleted, as with any other project.

Image processing

DxO ONE produces files in DNG (RAW), DxO (Super RAW), and JPEG formats, which are supported by all of the tools in the Customize tab. A few features are specific to the camera, however, such as the default preset, PRIME noise reduction, cropping when using the digital zoom, and scene modes.

For a complete description of the Customize tab and its tools, see the dedicated section in the user guide.

DxO ONE also produces video files that are not supported by DxO PhotoLab. To handle these videos, see the DxO ONE user guide.

EXIF palette information

In addition to the date and time of the shot as well as the exposure parameters, the EXIF palette EXIF displays information tied to DxO ONE:

- Identification of camera and lens models
- File type: RGB (.JPEG), RAW (.DNG), and Super RAW (.DXO)
- Exposure mode

Default mode scene and Optics Modules

As soon as you open a file, DxO PhotoLab applies a preset that is specific to DxO ONE, as well as the settings of the active scene mode. As ever, you can use the tools in the Customize tab to manually adjust these corrections.

You can deactivate the application of scene modes to RAW and SuperRAW files (see the Preferences section in the user guide).
DxO ONE also provides DxO Optics Modules already installed in the program - one for JPEG files, and another for RAW and SuperRAW files. The Optics Modules correct distortion, vignetting, and chromatic aberration, and optimize lens sharpness.

**Noise reduction**

DxO PhotoLab lets you correct digital noise in DxO ONE image files, depending on the file format:

- JPEG: HQ (Fast)
- RAW (.DNG): HQ (Fast) or DxO PRIME
- Super RAW (.DXO): HQ (Fast) or SuperRAW

For more information about which modes of noise reduction support which image file formats, see the Correction palette > Detail section in this user guide.

In the case of SuperRAW mode, the analysis and calculations are performed by weighting the four successive images saved when shooting, in order to produce the highest quality results possible.

SuperRAW mode is active by default for compatible files with the .DXO extension. However, you can deactivate this option in the DxO PhotoLab preferences (see the section on Menus and Preferences).

You can use High Quality (Fast) noise reduction with SuperRAW files, but in this case, only the first image in the series of four will be corrected.

**Cropping an image**

DxO ONE comes with a digital zoom that lets you crop an image and display only the part that remains after the crop. If you activate the Crop tool in DxO PhotoLab, it will display the entirety of the image (including cropped portions), with the grid showing the crop from the digital zoom. Of course, you can then modify the digital zoom crop.

**Scene modes**

There are five DxO ONE Scene modes:

- DxO ONE - Auto
- DxO ONE - Portrait
- DxO ONE - Landscape
- DxO ONE - Night
- DxO ONE - Sports

By default, DxO PhotoLab applies the scene mode selected in DxO ONE.

DxO ONE scene modes can also be applied to images taken with other cameras via the Presets window, or by right-clicking on a thumbnail in the Image browser and selecting the scene mode from the context menu.

You can deactivate the application of scene modes to RAW and SuperRAW files (see the Preferences section in this user guide).
Exporting images
Exporting images

About the Export feature

DxO PhotoLab features an export system that is fully integrated with the Organize and Customize tabs and that comprises five functions:

- **Export to disk**: Exports your images to a hard drive.
- **Export to application**: Lets you open image files (including RAW files) in external applications.
- **Export to Facebook**: Lets you transfer images to your Facebook page.
- **Export to Flickr**: Transfers your images to your online Flickr gallery.
- **Export to Lightroom**: Transfer images into Lightroom.

The Mac version of PhotoLab also automatically benefits from the sharing extensions defined in your OS, as soon as you activate them.

Exporting is the last step in the DxO PhotoLab workflow — the moment when all of the corrections you've made will be applied to the images you export to share with or send to your clients, friends, and family.
Exporting images

Interface

The Image Browser command bar consists of three buttons that are relevant to the Export function:

- **Export to** Disk, to Application, Facebook, or to Flickr (or to another sharing extension if you work in OS X), via a drop-down menu.

- **A progress button.** When you click on this button, a floating palette is displayed that indicates the progress of the export. A small progress bar also appears within the button itself during export.

To cancel an export, click on the progress button and then in the floating progress panel, click on the X next to the progress bar of the export that you want to cancel.

The floating progress palette displays a record of all of the exports performed during a session. You can delete the list of completed exports by clicking on the Erase button in the lower left corner of the palette.

There are two instances in which the export progress button is not visible: (1) after you launch DxO PhotoLab and thus have not yet exported anything, and (2) after you have erased the contents of the progress palette.

- **A magnifying glass for checking the exported image (OS X).** When the image export is finished, a small magnifying glass appears on the right side of the progress bar in the progress palette. If you click on it, a system dialogue box opens in the location of the exported image, allowing you to open and check it in Preview.
**Export to disk**

Exporting images consists of creating image files to which are applied the corrections you made in the Customize tab, and then transferring the corrected images to the hard drive and the folder of your choice, or to an external application, or to a Flickr gallery. All export choices require you to choose an output option. To do so, open the export options floating window by clicking on the **Export to Disk** button.

The purpose of the output options interface is to provide you with the settings you need that will automatically and simultaneously export images in different formats and to different destinations (ELITE Edition).

**File formats and their constraints**

Some image formats lose part of the file information to achieve a more compact size; these are referred to as lossy. Formats that keep all available information even while achieving a certain degree of compression are referred to as lossless.

JPEG is a lossy format, while TIFF and most RAW formats are considered lossless. DNG (Digital NeGative) is a very specific format designed by the Adobe software company to be a de facto standard for RAW files, which it has become to some extent.

The following table shows the possible relationships between input and output formats:

<table>
<thead>
<tr>
<th>Image input format</th>
<th>Possible export formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>JPEG, TIFF (8-bit)</td>
</tr>
<tr>
<td>TIFF</td>
<td>TIFF (8- or 16-bit, depending on the input image)</td>
</tr>
<tr>
<td>RAW</td>
<td>JPEG, TIFF (8- or 16-bit), DNG</td>
</tr>
</tbody>
</table>

**Output formats**

- **JPEG**: The JPEG format is for files that are going to be printed in photo labs, displayed online, or sent by email. DxO PhotoLab requires you to set the quality level when processing JPEG files. A slider lets you to set the degree of compression, and thus quality loss, from 0 to 100. Of course, the higher the quality, the larger the output file. Since JPEG is a lossy format, we advise choosing a higher quality setting (e.g., 90) and compensating if necessary by using a smaller image size. This is a better compromise than a larger image with a lower-quality setting.
• **TIFF**: The TIFF format is a lossless format designed for high-quality files that you intend to archive or which you will post-process further (all image editing applications can import TIFF images). When you choose TIFF format for an output image, you must also choose two specific settings:
  - **The compressed / uncompressed** option: We advise sticking with the uncompressed option, which results in a larger file, but is more widely accepted by post-processing programs than compressed TIFFs.
  - **8- or 16-bit encoding**: 8-bit encoding provides only 255 possible levels per color channel, while 16-bit encoding provides 65,536 shades of color. This choice is only available if the source image itself was originally coded in a 16-bit format (i.e., RAW or 16-bit TIFF format). We advise choosing the 16-bit format whenever possible, since it greatly improves color rendition. Furthermore, this format represents an excellent choice for preserving and archiving your images.

• **DNG**: The DNG format is designed for files that you intend to archive or that are going to undergo further post-processing with DNG-compatible software such as Adobe Camera Raw/Photoshop/Lightroom. The DNG generated by DxO PhotoLab is a 16-bit linear DNG format, which is only available for original images shot in RAW. With linear DNG, the three color channels have been individually calculated, which means that the file is three times larger than the original RAW file. This format offers the same advantages of reversibility as with a camera-generated RAW file.

• **Quality**: Lets you set the JPEG compression quality.

• **Destination**: By default, the destination folder is simply the same folder as the original or source image. This choice is indicated in the output options found in the Destination (Windows) or File (Mac) drop-down menu. If you select the Custom file option, a dialog window opens that will let you pick or create a folder on your hard drive. Note that the pathway can be either absolute (as in, for example, “C:PhotosSorties DxO PhotoLab”) or relative (DxO PhotoLab outputs). In the first case, all the images will be saved in one single destination folder, even if the source images are scattered among several different folders. In the second case, the images will be saved in a sub-folder within the source folder, which will allow you to keep the corrected images close to the originals. In this situation, there will be as many sub-folders created as there are source folders.

---

### All of the following options described below can be accessed by selecting Advanced settings in the export options floating window.

- **Suffix**: By default, DxO PhotoLab appends ".DxO" to any file name. You can replace this with any sequence of characters.

- **Resolution**: Lets you set the output resolution.

- **Resizing**: Changing the size of an image involves the process known as "resampling," which requires recalculating the number of pixels that make up the image. In all cases, resampling must be performed at the latest possible stage, since it destroys a certain amount of information in your image. So if you will need to do subsequent post-processing, we advise you to keep the initial image size. If you activate the Resize image option, you will have to choose among the following parameters:
  - **The maximum dimension** of the output image (whether by height or width) in pixels, centimeters, or inches. One single dimension is enough for the program to maintain the aspect ratio (the proportions) of the image.
  - **The interpolation method**: Several options are available: Auto is a good choice, but many photographers are loyal supporters of bicubic interpolation for optimum precision, and DxO PhotoLab offers a bicubic interpolation sharpen option.

- **ICC Profile (ELITE Edition)**: The ICC profile for the output file (with the exception of DNG format) can be the same profile as the source image, the sRGB, Adobe RGB, or a custom profile. The sRGB profile is particularly suitable for Web publication and inkjet printing, while Adobe RGB is best adapted to retouching and publishing. In these cases, TIFF is the ideal output format. A custom profile will allow you to choose a specific profile.

---

### Exporting to disk

Export to Disk is how you process and save your corrected images to your computer’s hard drive or peripheral drive. Before starting the export, you must check the boxes in the Export to Disk – Options window to enable the desired output options (even if you just create a new output option, it will be disabled by default). You must enable at least one option, but you can also activate as many as you want. This is one of the key features of DxO PhotoLab ELITE Edition, which allows you to simultaneously export multiple different files from the same source image.

---

**The export options let you create backup copies: all you have to do is do give the same name to an image but select a different**
To start processing and exporting the images you have selected in the Image Browser, all you need to do is to click on the Export to Disk button in the export options window. If an exported image has the same name as another image already in the destination folder, a dialog box will prompt you to either overwrite the image already in the folder, or to rename the image being exported so as not to overwrite the other file.

You can have DxO PhotoLab add a special suffix to the names of your processed files (see Export Options).

While the export is underway, a gear icon is displayed in the upper right corner of the thumbnails in the Image Browser, while a tiny overall progress bar is displayed in the Export button itself. You can access a larger version of the progression bar by clicking on the Export button, which opens the Progress palette.

The processing time will vary according to the size and number of images you export.

When processing is complete:
- An icon confirming the success of the operation will appear in the lower right corner of the thumbnail.
- If an error occurs, an exclamation point will be displayed.

You can change the number of images that can be processed simultaneously by going to Edit > Preferences > Performance > Display and processing (Microsoft Windows) or DxO PhotoLab > Preferences > Advanced (Mac OS X).

Creating an export option

To create a new export option, click on the Add new option button in the export options floating window. From there, choose the settings that you need. This said, certain settings are dependent on the type of output file (discussed in detail in the following section). Other settings are common to all file types, such as choice of destination folder, the suffix for the file name, and resizing parameters.
Export to application

You can export your images to other applications (such as Photoshop, Lightroom, etc.) to perform additional corrections. To do so:

1. Select the images to export in the Image Browser.
2. Open the drop-down menu immediately to the right of the Export to disk button and then select Export to application.
3. A dialogue box will open that will let you choose the external application from your operating system’s Applications folder.
4. After selecting the external application, choose from among the following options in the Action menu: Process as JPEG, TIFF, or DNG and Export, or export selected files without processing.
5. In the Action menu, choose the file format (process in JPEG, TIFF, DNG). You can also choose to export the image without applying any processing.
6. Click on Export: your file is processed and will open in the designated application.

If you export a RAW file by choosing the Export without processing the selected file(s), the destination application will not import the renderings and corrections you have applied in DxO PhotoLab.
Workflow with Lightroom

About workflow with Lightroom

DxO PhotoLab offers you an integrated and nondestructive workflow with Lightroom, allowing you to transfer your RAW-format images from the Lightroom editor to DxO PhotoLab for processing, and then send the processed photos back into Lightroom.

This feature is compatible with Lightroom 3, 4, and 5.

This workflow consists of two components:

1. A Lightroom plugin that lets you directly transfer your RAW images into DxO PhotoLab.
2. An Export to Lightroom feature in DxO PhotoLab that lets you export the processed RAW files in different output formats.

DxO PhotoLab automatically installs the plugin in the list of Lightroom plugins. In the event that the installation does not occur correctly, or if you have previously refused to install the plugin, or if you installed Lightroom after installing DxO PhotoLab on your computer, you can still launch the plugin installation by clicking on Export to Lightroom in DxO PhotoLab.

Transfer an image from Lightroom to DxO PhotoLab

To transfer an image from Lightroom to DxO PhotoLab:

- After you have selected your worklist in Lightroom, click on the images in the Filmstrip that you want to export.
- Select DxO PhotoLab from the File > Plugin – Extras > Transfer to DxO PhotoLab menu.
- DxO PhotoLab launches and creates a project which contains the images that you exported.
- Start processing your images.

The corrections that you have made to your RAW images in Lightroom are not transferred with those images into DxO PhotoLab.

At the end of the transfer, DxO PhotoLab automatically displays the Customize tab, the created project, and the Export to Lightroom button, so you can immediately start processing your images.
Export an image from DxO PhotoLab to Lightroom

1. After you have finished processing your images, select them in the Image browser.
2. Click on the Export to Lightroom button.
3. A dialog box will open.
4. In the Action menu, choose the file format: process as JPEG, TIFF, or DNG.
5. If necessary, choose the ICC profile to attach in the Advanced settings menu.
6. Click on Export.

If you want to make further changes to your images in Lightroom, we recommend that you select the DNG raw format, which will provide you with a range of corrections similar to those for RAW files. Otherwise, select either JPEG or TIFF format.

The images exported to Lightroom are gathered together in a collection whose name includes the date and time of export. An ensemble of DxO PhotoLab collections is created to keep all such processed collections together. Processed files are visible in the Lightroom filmstrip in file system mode, and are associated with the corresponding stack of original RAW images.

You can repeat the procedure by selecting the original RAW images in Lightroom: DxO PhotoLab will preserve the corrections that you have made to your images. If you overwrite the output file, any additional corrections performed in Lightroom will also be preserved.

If you have assigned star rankings to your RAW images in the Lightroom Library or in another software application, they will be automatically read by DxO PhotoLab from the EXIF or XMP data. If you have assigned a color or associated keywords to your images, this kind of data will not be visible in DxO PhotoLab, but it will be preserved: it will be visible in Lightroom again after the transfer is completed. These two functions require the presence of an XMP file for images coming from Lightroom. To do so, check the Automatically write the changes in XMP format in sidecar files box in the Edit > Lightroom catalog parameters menu. The Preserve XMP data for RAW images option box must also be checked in the General tab in the DxO PhotoLab Preferences.

The stars defined in DxO PhotoLab are written in the output files and can be read by other programs.
Export to Facebook

**Export to Facebook dialog box (Microsoft Windows)**

To export your images to Facebook:

1. Select one or more images in the Image Browser.
2. Click on the arrow to the right of the Export button and then choose **Export to Facebook**.
3. In the Options floating window, connect to your Facebook account.
4. If you have several albums in your Facebook account, pick the one you want in the Album drop-down window.
5. In the **Action** drop-down menu of the Processing options (Microsoft Windows) or the **Format** section (OS X), choose **Process as JPEG and Export**.
6. Use the **Quality** slider to adjust the JPEG compression.
7. You can resize your image(s) in the Advanced settings (Microsoft Windows) or Resize section (OS X) by clicking on the Allow image resampling checkbox, entering a value in the Largest size dimension field, and then choosing an interpolation method (Auto by default).
8. Click on **Export**: DxO PhotoLab launches the processing as well as the export. A progress bar will display next to the progress button in the Source browser command bar.
9. As soon as the export is finished, check your Facebook page and the selected album. You can go there directly by clicking on the progress button, which will open the Export progress window, and then by clicking on loupe located at the right of the relevant progress bar.

*If you are exporting JPEG images that you have already processed, you can also select Export without processing selected file(s). Be aware that Facebook accepts only JPEG-formatted images.*

*Facebook automatically resizes images to 2048 pixels unless you select a smaller size, in which case the size you specify will be applied to your image(s).*
Export to Flickr

After you have clicked on the arrow to the right of the Export button for the first time and then chosen Export to Flickr in the drop-down menu, a floating window will prompt you to connect to Flickr.

1. Click on Connect.
2. Your default web browser will launch.
3. On the Yahoo Flickr home page, enter your user ID and password.
4. In the Flickr options, select the desired batch of photos and enter whatever keywords you want. You can also choose if you want the images to be private or public.
5. Return to the DxO PhotoLab interface, and enter the confirmation code.
6. A window will confirm that the authorization has been approved.

To export your images to your Flickr gallery:

1. Select one or more images in the Image Browser.
2. Select Export to Flickr mode.
3. In the floating window, connect to your Flickr account.
4. In Export to Flickr - Options, select the batch of photos and enter the tags you want. Also choose if you want your images to be public or private.
5. Select the export method from among the ‘Process as’ options:
   - RAW files: Process as JPEG and export.
   - TIFF or JPEG files: Process as JPEG or Export without processing the selected file(s).
6. Use the Quality slider to set the JPEG compression.
7. Click on Enable resizing from among the Resize options, enter a value in the Largest Size field, and select an Interpolation method (Auto by default).
8. Click on Export: DxO PhotoLab launches image processing and then export. A progress bar is displayed in the Image Browser command bar to the left of the Print command icon on the right side.
9. As soon as the transfer is completed, check your Flickr page.

In contrast to previous versions of DxO PhotoLab, it is no longer necessary to process your images before exporting them to your Flickr gallery.
The print module (Microsoft Windows)

The print module lets you print any of the file types supported by DxO PhotoLab, including RAW files and virtual copies, before or after processing. It is not necessary to export images in order to print them, and the print module can be called from either the Organize or the Customize tab.

The print module automatically lists every printer connected to your computer, including virtual PDF printers.

Color management is handled either by the printer driver or by DxO PhotoLab, with the latter giving you the option of choosing an ICC profile and adjusting the rendering and print sharpness.

Tools and settings

Interface

After selecting one or several images, the print module can be called as follows:

- By clicking on the **Print** button in the Image Browser command bar.
- By selecting the **File > Print selected images** menu.

A large floating window appears on top of the DxO PhotoLab Viewer pane. It is divided in two sections:

- A print preview area on the left that displays the images and pages to be printed (use the arrows to navigate through the different items).
- A settings column on the right that contains all the printer controls and adjustments.

In the bottom right corner of the Print module window, you will find the **Print** button (which opens a floating print progress bar) and the
Printer parameters

The first palette is devoted to the printer:

- **Name**: The drop-down list shows all the printers installed and connected to your computer. Select the printer you want to use (if you do not want to use the preselected default printer).
- **Paper size**: Shows the paper size per the printer driver.
- **Orientation**: Shows the portrait or landscape orientation per the printer driver.
- **Resolution**: Shows the default resolution (300 dpi) per the printer driver, and allows you to select another resolution if desired.

![The maximum print resolution is 1200 dpi.]

Color and sharpness

- **Color profile**: The Color and sharpness palette lets you manage the print colors in two ways: either through the printer driver, or by selecting an ICC profile and rendering mode yourself via the Color profile drop-down menu.

  - **Managed by the printer**: As soon as the printer parameters have been set (see the paragraph on Printer settings above), no further intervention on your part is necessary, since the printer driver manages the colors during printing.

  ![The following rendering modes will appear as soon as you choose an ICC profile in Color management by DxO PhotoLab mode.]

  - **Managed by DxO PhotoLab**: Selecting this mode displays the following menus:
    - **Import ICC profiles**: A dialogue box lets you select directly from among the folders containing the ICC profiles installed on your computer.
    - **Rendering mode**: This menu lets you choose from among four colorimetric rendering modes:
      - **Perceptual**: This mode compresses the gamut and modifies all colors so that they are printable. This is the rendering that is best for printing photographs.
      - **Saturation**: This mode ensures color matching between the source color space and the target color space. It is best suited for emphasizing brilliant colors.
      - **Relative colorimetry**: This mode lets you preserve colors as faithfully as possible (particularly important when dealing with a logo or trademark, etc.), but in contrast to absolute colorimetry mode below, the source white space is converted to the target white space.
      - **Absolute colorimetry**: This mode also lets you faithfully preserve colors, but unlike the Relative colorimetry mode above, the source white space remains unchanged.

  ![When color management is provided by DxO PhotoLab, you must ensure that the color options in the printer driver are disabled (a warning message is displayed in the palette).]

  - **Sharpness**: The Sharpness slider lets you reinforce the sharpness of your images when you print them. The slider is set by default to 50 on a scale of 100.

  ![Sharpening adapts automatically to the size of the print, but you can still use the slider to adjust the sharpness to suit your tastes and the size of the prints.]

  ![On-screen previewing of sharpness enhancement is not possible. We advise you to experiment with paper tests to determine the settings that work best for your photos, according to your personal tastes.]
Layout

The Layout palette lets you create contact sheets by using the Rows and Columns sliders or by entering the number of rows and columns desired in the appropriate fields. There are also two optional checkboxes:

- **Crop to fill**: When checked, the image will fill the page (and may end up being cropped).
- **Rotate to fit**: When checked, the print module will rotate the image in order to fill the page.

Margins

The margin sliders let you adjust the margin sizes on the page perimeter. You can select the measurement units (centimeters, inches, etc.) in the drop-down menu.

Cell size

The Height and Width sliders let you make the following changes so you can adapt the page or pages to the content that you want to print:

- **Single image**: One lone image on the page is a cell by itself; use the height and width slider to move the image horizontally and/or vertically.
- **Multiple images or contact sheets**: Use the sliders to modify the size of the image cells as well as the spacing between the cells, both horizontally and vertically.

Image caption

You can add captions to and position them on your images, and then choose the font type, size, etc.

The Caption drop-down menu has four options:

- **None** (i.e, no caption).
- **Image name** (basically, the file name).
- **Image name and date**.
- **Image name and metadata** (which includes the shutter speed, aperture value, and focal length and ISO value, etc.).

> The **Position** drop-down menu lets you position the caption below, above, or on the left or right side of the image.

The Font settings let you choose any font type, size, style, effect, and color available on your computer (a system window will open for that purpose).

> The settings are saved when you quit the print module. If you want to set up a different layout or change other settings, you will need to reset the sliders one by one by double-clicking on each one.
# Printing

## OS X

![The Print module (OS X)](image)

**Tools and settings**

**Interface**

The print menu uses the operating system interface. After selecting one or more images, you can print from either tab as follows:

- By clicking on the **Print** button in the Image Browser command bar.
- By selecting **File > Print selected images** menu.

A large floating window will appear on top of the DxO PhotoLab Viewer pane. It is divided in two sections:

- A print preview area on the left that displays the images and pages to be printed (use the arrows to navigate through the different items).
- A settings column on the right side that contains all the printer controls and adjustments.

In the bottom corner of the Print module window, you will find the **Print** button (which opens a floating print progress bar) and the **Cancel** button.

**Settings**

**Printer parameters**

The first two drop-down menus on the upper right are devoted to the printer:

- **Printer**: The drop-down list shows all the printers installed and connected to your computer that you can use to print your photos.
- **Presets**: This menu lets you save and then choose your printing configurations.

A third drop-down menu in the center offers image settings for DxO PhotoLab and for the printer driver (see below). (If you do not see this...
third menu, click on the Show Details button in the lower left of the print window.)

**DxO - Image parameters**

- **Crop to fill**: When checked, the image will fill the page (and may end up being cropped).
- **Rotate to fit**: When checked, the print module will rotate the image in order to fill the page.
- **Add caption**: Lets you add and place a caption as well as choose a font and style.

There are three caption options:

- **Image name**: the file name.
- **Image name and metadata** (which includes the shutter speed, aperture value, focal length, ISO value, etc.).
- **Image name and date**.

The **Position** drop-down menu lets you position the caption below, above, or on the left or right side of the image. The Font menu lets you choose any font type, size, style, effect, and color available on your computer (a system window will open for that purpose).

**DxO - Layout**

- **Margin**: Enter the margin dimensions for the page (top, bottom, sides).
- **Layout**: The sliders let you adjust the number of rows and columns (especially useful for creating contact sheets).
- **Cell Size**: You can specify the size of the cells by entering values, or by using the Auto mode. In the latter case, all available space will be used.
- **Other settings**: All other parameters, such as type of paper, paper size, orientation, etc., are set in the printer driver, accessible via the central drop-down menu.

> The maximum print resolution is 1200 dpi.

**DxO - Sharpness**

The **Sharpness** slider lets you reinforce the sharpness of your images when you print them. The slider is set by default to 50 on a scale of 100.

> Sharpening adapts automatically to the size of the print, but you can still use the slider to adjust the sharpness to suit your tastes and the size of the prints.

> On-screen previewing of sharpness enhancement is not possible. We advise you to experiment with paper tests to determine the settings that work best for your photos, according to your personal tastes.
Menus and preferences

Microsoft Windows

Menus

File

- New project: Creates a new DxO PhotoLab project.
- Recent locations: Gives direct access to recently-created or opened projects.
- DxO PhotoLab database: Lets you save or restore your database.
- Export image for ICC profile: Saves images that can be used by professional calibration programs to create ICC profiles (linear RAW or realistic color rendering options are available).
- Sidecars: Exports the individual settings file of the selected images to the same directory as the original images, or imports the sidecars (the individual settings file for each image) of currently-selected images from the same directory as the original images in .dop format. Sidecars allow you to transfer all correction settings of an image from one computer to another or share them with other users. Note that Mac and PC sidecars are compatible with one another.
- Export to disk: Lets you export images to a hard drive.
- Export to application: Lets you transfer processed or original images to an external application.
- Export to Facebook: Lets you transfer images to a Facebook page.
- Export to Flickr: Lets you transfer images to a Flickr online gallery.
- Export to Lightroom: Lets you transfer images into Lightroom.
- Print: Lets you start the print module.
- Exit: Lets you quit from DxO PhotoLab.

Edit

- Undo and Redo: Each command affects the last action performed.
- Select All: Lets you select all the images displayed in the Image Browser.
- Rename file: Lets you rename the selected image file (the change is also saved to your hard drive).
- Preferences: Lets you customize the software (see the Preferences section below for more details about specific options).

View

The upper section of the View menu lets you move from one tab to the other, and the lower section controls the way in which images are displayed in the Viewer.

Some of the following commands can be either active or inactive, depending on the tab you are in.

The lower part is divided into four sections that contain the following options:

- Image information overlay: Displays a floating window containing various information about the selected image.
- Grid overlay (Customize tab): Lets you superimpose a grid on an image (you can choose the size and the color in the Preferences), and hide it when you are finished using it.
- Refresh: Updates the Image Browser display of the contents of the selected folder or project.
● Show/Hide Source Browser (Organize tab): Lets you hide or display the pane that contains your folders and projects.
● Show/Hide Image Browser: Lets you hide or display the Image Browser — that is, the row of image thumbnails located on the bottom of the application window.
● Show/Hide all palettes (Customize tab): Lets you show or hide all the correction palettes in one go.
● Maximize interface: Lets you hide the title bar and the browser navigation bar.
● Full screen (Viewer): Lets you display images in full-screen mode without any UI elements showing.
● Live Review: Automatically displays each new image added to the current folder. This feature is useful notably for photographers who work with a camera attached to their computer (third-party software is necessary to control the camera).
● Dock/Undock Image Browser: Lets you toggle the full-screen display mode.

**Image**

● Apply a preset: Lets you select a preset from the drop-down menu and apply it to the selected image.
● Create preset from current settings: Lets you create a preset based on the current correction settings for the selected image.
● Copy correction settings: Lets you copy the settings of the current image to apply them to another image or batch of images.
● Paste correction settings: Once you have selected a new image, this command lets you paste the settings that you have previously copied.
● Resolve DxO Optics Module ambiguities: A dialog box opens that will let you manually resolve any ambiguities about which DxO Optics Module should be used.
● Rotation: Lets you rotate the image 90° to the left or right.
● Show input file in Windows Explorer: Lets you see the location in the system of the selected input file.
● Show output file(s) in Windows Explorer: Lets you see the location in the system of the selected output file.
● Open input image/ output image with: Lets you open a source image or output image in a third-party application. When you first use this option, the Browse command will let you choose the application you want to use.
● Create Virtual Copy: Automatically generates a virtual copy and displays it in the Image Browser, with a sequence number (2, 3, etc.; 1 is reserved for the original image).
● Create project from current selection: Lets you create a new project from images you select in the Image Browser.
● Add current selection to project: Allows you to add images you select in the Image Browser to an existing project.
● Remove...: This command behaves differently depending on the situation:
  ● In a project, the selected image will be removed from it (but not moved to the trash).
  ● In a folder without virtual copies, the image is moved to the trash.
  ● In a folder containing virtual copies which are all selected, all selected files are moved to the trash.
  ● In a folder containing virtual copies which are not all selected, only the virtual copies (including from the associated projects) are removed.
● Set tag: indicate which images should or should not be picked or rejected, thus processed or not.
● Rate: let you grade the quality of your images.
● Image properties: Displays a floating window with a certain amount of information about the selected image (e.g., name, pathway, EXIF data, associated DxO Optics Module, etc.).

**DxO Optics Modules**

This menu lets you manage DxO Optics Modules, which are indispensable for completely automatic processing of your images:

● Download additional DxO Optics Modules... (Internet connection required): Lets you connect to the DxO Labs server to download any DxO Optics Modules that have not been previously installed on your computer. The Optics Modules will be operational as soon as they are downloaded.
• Installed DxO Optics Modules... Displays the list of Optics Modules already installed, and lets you uninstall any Optics Module that is not currently in use.

• DxO Optics Modules roadmap (Internet connection required): Connects you to a page on the DxO Labs website containing a list of supported and planned DxO PhotoLab Modules (you can find the planned Modules in the list by clicking on the Available column header).

• Suggest a DxO Optics Module to DxO Labs (Internet connection required): Connects you to a form on the DxO Labs website on which you can suggest a DxO Optics Module for DxO Labs to produce.

Palettes (Customize tab)

• Hide/show palettes: You can check or uncheck the palettes in the list that you want to hide or show.

• Create user palette: Lets you create a custom palette into which you can add the palettes of your choice. A dialog box lets you enter a name for the new palette.

• Show/Hide all palettes: Lets you hide or display all of the palettes in one go.

Workspace (Customize tab)

This menu lets you create and select a workspace:

• DxO Standard: The default workspace selection.

• User workspace(s): One or more custom workspaces that you can select from a list (the name or names will appear in the menu; see below).

• Save workspace: Lets you save a custom workspace (a dialogue box will prompt you to enter a name for the workspace and to validate it).

• Delete workspace: Lets you delete the selected (active) workspace.

Help

The Help menu contains several different sources of help and information about how to best use DxO PhotoLab:

• DxO PhotoLab online help: Launches the online User Guide.

• PDF user guide

• Online support and resources (Internet connection required): Opens DxO online help.

• DxO Academy (Internet connection required): Takes you to the home page of the DxO Academy, where you can find tutorials, webinars, and downloadable DxO software user guides.

• Shortcuts: Displays a list of keyboard shortcuts.

• Check for update... (Internet connection required): If you select this option, the application will contact the DxO Labs server to check if you have the very latest version of the program installed on your computer. If this is not the case, a dialog box will offer you the possibility of downloading and installing the latest version.

• Activate DxO PhotoLab...: Lets you activate DxO PhotoLab.

• DxO ViewPoint: Lets you activate DxO ViewPoint.

• DxO FilmPack: Lets you select and activate the relevant version of DxO FilmPack.

• Websites (Internet connection required): These links let you directly access the home page for DxO Labs, the DxO Facebook page, and the DxO Twitter feed.

• About DxO PhotoLab: Displays the About DxO PhotoLab window, where you will find information about the version you are using and any add-ons currently installed. This information is especially useful if you need to contact DxO Labs technical support.
Right-click

The right-click menu in the Image Browser and the Viewer (accessible from both the Organize and Customize tabs) contains the following functions:

- Export to disk: Lets you export your images to the hard drive of your computer or to a peripheral drive.
- Export to application: Lets you export images to an external application.
- Export to Facebook: Exports your images to your Facebook timeline.
- Export to Flickr: Exports your images to your Flickr photostream.
- Export to Lightroom: transfer images into Lightroom.
- Print: Opens the print module.
- Apply a preset: Lets you select a preset from the drop-down menu and apply it to the selected image.
- Create preset from current settings: Lets you create a preset based on the current correction settings for the selected image.
- Copy correction settings: Lets you copy the settings of the current image to apply them to another image or batch of images.
- Paste correction settings: Once you have selected a new image, this command lets you paste the settings that you have previously copied.
- Create project from current selection: Lets you create a new project from images you select in the Image Browser.
- Add current selection to project: Allows you to add images you select in the Image Browser to an existing project.
- Rename file: Lets you rename the selected image file.
- Remove...: This command behaves differently depending on the situation:
  - In a project, the selected image will be removed from it (but not moved to the trash).
  - In a folder without virtual copies, the image is moved to the trash.
  - In a folder containing virtual copies which are all selected, all selected files are moved to the trash.
  - In a folder containing virtual copies which are not all selected, only the virtual copies (including from the associated projects) are removed.
- Rotation: Lets you rotate the image 90° to the left or right.
- Load original image file folder: In a project, this command lets you access an image file in its original folder.
- Show input file in Windows Explorer: Lets you see the location in the system of the selected input file in the Source Browser.
- Show output file(s) in Windows Explorer: Lets you see the location in the system of the selected output file.
- Open output images with: Lets you open a output image to a third-party application. When you first use this option, the Browse command will display a window that will let you choose the application you want to use.
- Create Virtual Copy: Automatically generates a virtual copy and displays it in the Image Browser, with a sequence number (2, 3, etc.; 1 is reserved for the original image).
- Set tag: indicate which images should or should not be picked or rejected, thus processed or not.
- Rating: Allows you to rank images by quality using a star-rating system. (Visible if the “Ranking stars” option has been activated in Preferences).
- Image properties: Displays a floating window with a certain amount of information about the selected image (e.g., name, pathway, EXIF data, associated DxO Optics Module, etc.).
Preferences

The Preferences are accessible in the Edit > Preferences menu. The Preferences window includes three tabs.

General tab
The General tab is organized in the following manner:

Application preferences
- **Application language** lets you choose the UI language (requires restarting DxO PhotoLab).
- **Automatically check for updates** lets the application search for the latest updates (Internet connection required). Activating or deactivating this option requires restarting the application.
- **Agreement to participate or not in an anonymous product improvement program by DxO**. This program sends a limited set of technical data about your system configuration and about your DxO projects to DxO Labs. This helps DxO enhance its products and improve your experience. (Click on the Product improvement program link in the tab for more details.)

Processing
- **Use legacy (v2.0 and earlier) FilmPack color handling**: If you own and DxO FilmPack v3.0 (and higher), this setting lets you use the color renderings of DxO FilmPack v2.0 (and earlier versions). Relaunching the application is required.
- **Preserve metadata in XMP sidecars for RAW images**: Allows the application to process and export your RAW images while using metadata previously stored in an XMP-format file alongside the input image (e.g., metadata created by a program such as Adobe Bridge).

Correction settings
- **Save settings in sidecar file (.dop) automatically**: Settings files (or sidecars) are small text files associated with an image whose names include the extension ".dop". They contain information for correcting images. If you want to transfer images to another computer using DxO PhotoLab, you can also transfer their sidecars settings. That way, when you add these images to your project (after checking that automatic loading is enabled on the other computer; see below), the corrections made on the original computer will show up on the destination computer. Note that you can also upload files to Settings via the File > Sidecars > Import menu.
- **Load settings from sidecar file (.dop) automatically**: You can automatically include any existing sidecar information associated with image files that you download from another source.
  - **Default preset for new RAW images**: Lets you select a default preset that will be applied to all RAW images when you browse through your folders, and which will be initially applied to them in the Image Browser. The application default preset is 1 – DxO Standard.
  - **Default preset for new RGB images**: Lets you select a default preset that will be applied to all RGB (JPEG, TIFF, DNG) images when you browse through your folders, and which will be initially applied to them in the Image Browser. The application default preset is 1 – DxO Standard.
  - **Automatically apply scene mode presets for DxO ONE RAW and SuperRAW images**: Selected by default, this option allows DxO PhotoLab to apply the active scene mode in DxO ONE to RAW (.DNG extension) and SuperRAW (.DXO extension) files. If unchecked, only the default preset specific to DxO ONE will be applied.
  - **Automatically use SuperRAW noise reduction for DxO ONE SuperRAW images**: Selected by default, this option uses SuperRaw noise reduction when a DxO ONE SuperRAW (.DXO extension) file is active. If unchecked:
    1. For images that have already been processed, SuperRAW remains the default noise reduction mode.
    2. For new images, the default noise reduction mode is High Quality (Fast).

DxO PhotoLab database
- **Location**: Indicates the pathway for accessing the DxO PhotoLab database. If you click on Browser, a dialog box will show you where this is located in the system.
Display tab

The Display tab is composed of three parts: Choices that are common to different stages in image processing (Common), and others which are specific either to the Customize tab, or to the Image Browser.

Common

- **ICC profile used for display** gives you three options for entering the ICC profile of your screen:
  - **Current profile of the display device**, if you have calibrated it with a colorimeter.
  - **Generic profile sRGB** (use this option if in doubt).
  - **Adobe RGB profile**, to use only with a high-quality screen for which you know the specific Adobe RGB range.

- **Window background**: This slider allows you to lighten or darken (white to black) the Viewer, which is the principal window for displaying and working on images. This setting does not affect other panels. To return to the default setting, double-click on the slider.

- **Display DxO Optics Module download window when images for which no DxO Optics module is loaded are found**

Customize tab

- **Overlay grid size**: lets you set the size of the grid that you can superimpose on an (Display menu > Grid).

Image Browser section

You can choose Always ON, Always OFF, and On mouseover for displaying the following six options for each thumbnail:

- **Processing status** indicates if a file is waiting for processing, processed, etc.
- **Image name** shows if the image is a RAW or RGB-type file.
- **Tag** indicate which images should or should not be picked or rejected, thus processed or not.
- **Rating** let you grade the quality of your images.
- **DxO Optics Module status** shows if a DxO Optics Module is available or not.
- **The Delete button** lets you remove an image from the project or hard drive.

Performance tab

Cache

The cache is the embedded memory your computer uses to store DxO PhotoLab previews and thumbnails. Increasing the cache size, especially if you regularly process a large number of photos, improves the performance of DxO PhotoLab. In this section, in addition to the cache size, you can determine where the cache storage folder should be located by using the Browse button. You can also empty the contents of the cache by using the Clear button.

You can see the current size of the cache by hovering over the cache slider with your cursor.

Display and process

- **Enable OpenCL** improves not only the thumbnail display, but lets you take advantage of computing power for image processing. When you first start DxO PhotoLab, a performance test will determine if the graphics card (GPU) is faster than the processor (CPU). If the CPU is faster, OpenCL will be grayed out and inaccessible.

- **Maximum number of simultaneously processed images**: By default, the number of images that you can process at the same time is 2, but if your computer is sufficiently powerful, you can increase this number.
Menus and preferences

OS X

Menus

DxO PhotoLab (application menu)

- About DxO PhotoLab: Displays the About DxO PhotoLab window, where you will find information about the version you are using and any add-ons currently installed. This information is especially useful if you need to contact DxO Labs technical support.
- DxO FilmPack: lets you select a version of DxO FilmPack and activate it.
- DxO ViewPoint: lets you select a version of DxO ViewPoint and activate it.
- Check for updates
- Preferences: Opens the Preferences window.
- Hide DxO PhotoLab
- Hide Others
- Show All
- Quit DxO PhotoLab

File

- New Project: Creates a new DxO PhotoLab project.
- Recent Projects: Gives direct access to recently-created or opened projects.
- Close Window
- Project database: Allows you to create a backup of the database or to restore a backup of the DxO database.
- Sidecars: Exports the sidecars of the selected images to the same directory as the original images, or imports the sidecars of currently-selected images from the same directory as the original images (the individual settings file for each image) in .dop format. Sidecars allow you to transfer all correction settings of an image from one computer to another or share them with other users.
- Print format: Opens a dialog box that lets you select the format, size, and page orientation for printing.
- Print: Opens the print menu.

Edit

- Undo and Redo: Each command affects the last action performed.
- Cut: Lets you cut out selected text or objects from their current location and put them into the system clipboard.
- Copy: Lets you copy selected text or objects and place them in the system clipboard. The original text or objects remain at their current location.
- Paste: Lets you copy the content of the system clipboard to the current cursor position (for example, personal details to be added into the image EXIF field).
- Select All: Lets you select all the images displayed in the Image Browser.
View

The View menu lets you move from one tab to the other and controls the way in which images are displayed in the Viewer.

- The first part of the menu lets you move from either the Organize or Customize tab to the other.
- Show/Hide Source Browser (Organize tab): Lets you hide or display the pane that contains your folders and projects.
- Display original and corrected images side-by-side (both tabs): Lets you compare the effects of your settings and corrections to the original image.
- Reference image (both tabs): Lets you designate the reference image according to the following criteria: As shot [default], No Output, No Virtual Copy.
- Show/Hide Image Information overlay (both tabs): Hides or displays the information overlays provided by DxO PhotoLab (Correction Preview, Original, etc.).
- Display Grid (Customize tab): Lets you superimpose a grid on an image (you can choose the size and the color in the Preferences), and hide it when you are finished using it.
- Zoom in / Zoom out (both tabs): Zooms into the image and back out.
- Fit to screen (both tabs): Displays the full image in the Viewer.
- Full size (both tabs): Displays the image at 100%.
- Show Highlight clipping (both tabs): An overlay mask indicates the clipped highlight values in the image.
- Show Shadow clipping (both tabs): An overlay mask indicates the clipped dark values in the image.
- Palette (Customize tab): This menu allows you to hide or show correction palettes, and to create new palettes.
- Workspaces (Customize tab): This hierarchical menu lets you switch between the Standard workspace and your own custom workspace, and to save or delete a custom workspace.
- Docks (Customize tab): Hides or displays the lateral panes.
- Dock/Undock Image Browser (both tabs): Lets you dock the Image Browser on the bottom of the screen or lets you undock it and move it elsewhere as a floating window.

Image

- Apply Preset: Lets you select a preset from the drop-down menu and apply it to the selected image.
- New preset from current settings: Lets you create a preset based on the current correction settings for the selected image.
- Import Preset: Allows you to import a customized preset.
- Copy Correction Settings: Lets you copy the settings of the current image to apply them to another image or batch of images.
- Paste Correction Settings: After selecting one or more images, this command lets you paste the correction settings that you just copied in order to apply them to the selected images.
- Export to disk: Lets you process and then export images to a hard drive.
- Export to Application: Processes and then opens images in an application of your choice.
- Export to Facebook: Lets you export images to your Facebook timeline.
- Export to Flickr: Lets you export images to your Flickr gallery.
- Export to Lightroom: transfer images into Lightroom.
- Rotation: Lets you rotate the image 90° to the left or right.
- Set tag: indicate which images should or should not be picked or rejected, thus processed or not.
- Rate: let you grade the quality of your images.
Remove: This command behaves differently depending on the situation:
- In a project, the selected image will be removed from it (but not moved to the trash).
- In a folder without virtual copies, the image is moved to the trash.
- In a folder containing virtual copies which are all selected, moves all selected files to the trash.
- In a folder containing virtual copies which are not all selected, removes only the virtual copies (including from the associated projects).

Reveal original image in Finder: Shows the location of the original image in the Finder.
Reveal corrected image in Finder: Shows location of the corrected image in the Finder.
Rename on disk: Lets you rename the selected image (you cannot perform batch renaming).
Fix image path: If an image referenced in a project is missing, this command will let you search for it and re-add it to a project.
Create virtual copy: Automatically generates a virtual copy and displays it in the Image Browser, with a sequence number (2, 3, etc.; 1 is reserved for the original image).
Create project from current selection: Lets you create a new project from images you select in the Image Browser.
Add current selection to project: Allows you to add images that you select in the Image Browser to an existing project.

DxO Optics Modules

This menu lets you handle the DxO Optics Modules required for fully automating your image processing:
- Download missing DxO Optics Modules: Connects you to the Internet so you can add new modules. These modules will be operational as soon as they have finished loading.
- Manage DxO Optics Modules: Displays all available DxO Optics Modules and lets you download the ones you select to your computer. Also lets you uninstall a DxO Optics Module that you have already downloaded (so long as it is not currently in use). You can filter the list to show only the list of DxO Optics Modules already installed on your computer by checking the "Show only installed DxO Optics Modules" box.
- DxO Optics Modules Roadmap (Internet connection required): Connects you to a page on the DxO Labs website containing a list of supported and planned DxO PhotoLab Modules (you can find the planned Modules in the list by clicking on the “Available” column header).
- Suggest a DxO Optics Module to DxO Labs (Internet connection required): Connects you to a form on the DxO Labs website in which you can suggest a DxO Optics Module for DxO Labs to produce.

Window

- Minimize: Collapses the application window into the OS X dock.
- Zoom: Fits the application main window (all panes) to the screen size.
- Bring All to Front: OS X command bringing all the application windows in front of other applications open at the same time.
- Name of the folder / Project: Shows the name of the current folder or Project.

Palettes (Customize tab)

This menu lets you manage the tool palettes in the Customize tab:
- Display or hide palettes: lets you check or uncheck the palettes that you want to display or hide.
- New palette: lets you create an empty palette in which you can add the palettes you want. The dialog box will prompt you to enter a name for the new palette.
Workspace (Customize tab)

This menu lets you create and choose a workspace:

- **DxO Standard**: default workspace.
- **User workspace**: lets you select a custom workspace that appears in the menu (see above).
- **Save workspace**: lets you save a customized workspace (a dialog box will prompt you to enter a name for the workspace and then to save it).
- **Delete workspace**: lets you delete the workspace currently being used.

Help menu

The Help menu contains several different sources of help and information about how to best use DxO PhotoLab.

- **DxO PhotoLab help**: Lets you consult integrated help topics.
- **Online help** (Internet connection required): Opens DxO online help.
- **DxO Academy** (Internet connection required): Takes you to the home page of the DxO Academy, where you can find tutorials, webinars, and downloadable DxO software user guides.
- ** Websites** (Internet connection required): These links let you directly access the home page for DxO Labs, the DxO Facebook page, and the DxO Twitter feed.

Preferences

You can access the Preferences via the DxO PhotoLab drop-down menu. The Preferences window is divided into five tabs.

General tab

- **On startup**: DxO PhotoLab automatically checks for updates upon launch.
- **Dialogs**: Automatically show the DxO Optics Module download window displays the DxO Optics Module download window if an image is discovered for which a DxO Optics Module is available, but has not yet been installed on your computer.
- **Default presets**:
  - **Default preset for new RAW images**: Lets you select a default preset that will be applied to all RAW images when you browse through your folders, and which will be initially applied to them in the Image Browser. The application default preset is 1 – DxO Standard.
  - **Default preset for new RGB images**: Lets you select a default preset which be applied to all RGB (JPEG, TIFF, DNG) images when you browse through your folders, and which will be initially applied to them in the Image Browser. The application default preset is 1 – DxO Standard.
- **Automatically apply scene mode presets for DxO ONE RAW and SuperRAW images**: Selected by default, this option allows DxO PhotoLab to apply the active scene mode in DxO ONE to RAW (.DNG extension) and SuperRAW (.DXO extension) files. If unchecked, only the default preset specific to DxO ONE will be applied.
- **Automatically use SuperRAW noise reduction for DxO ONE SuperRAW images**: Selected by default, this option uses SuperRaw noise reduction when a DxO ONE SuperRAW (.DXO extension) file is active. If unchecked:
  1. For images that have already been processed, SuperRAW remains the default noise reduction mode.
  2. For new images, the default noise reduction mode is High Quality (Fast).
- **Statistics**: Indicates your willingness to participate or not in an anonymous product improvement program by DxO. This program sends a limited set of technical data about your system configuration and about your DxO projects to DxO Labs. To help DxO enhance its products and improve your experience. (Click on the Learn more link in the tab for more details.)
Display tab

- **Image background color**: Lets you pick the background color for the Viewer window in which your images are displayed.
- **Grid color**: Lets you pick the color of the Grid overlay tool and (if box is checked) display it in inverse video.
- **Grid size**: Sets the size of the grid cells.

Thumbnails tab

Icon display options:

- **Color tag**: Indicate which images should or should not be picked or rejected, thus processed or not.
- **Rating stars**: Let you grade the quality of your images.
- **DxO Optics Module icon**: Displays the status of a DxO Optics Module.
- **Processing status icon**: Shows if an image is waiting to be processed, has been processed, is undergoing processing, etc.
- **Delete button**: Lets you delete an image or a virtual copy from a project or folder.

Process tab

- **Processed images extensions**: Lets you modify the extensions of the three principal types of files, JPEG, TIFF, and DNG, which means that you can transfer files to systems or software which require extensions that are only three letters long (.JPG instead of .JPEG, for example).
- **Preserve metadata in XMP sidecars for RAW images**: Checking this box allows the application to process and export your RAW images while using metadata previously stored in an XMP-format file alongside the input image (e.g., metadata created by a program such as Adobe Bridge).

Advanced tab

**Performance**

- **GPU acceleration**: Lets you make use of the graphics card (GPU) to speed up the display. You should disable this control if it causes your display to be unstable.
- **Disable noise reduction preview at zoom levels lower than 75%**: You can prevent DxO PhotoLab from displaying a preview of noise reduction when the zoom value is 75%. The preview is disabled by default (when activated, the responsiveness of the application can be reduced, depending on how powerful your computer is).
- **Maximum number of simultaneously processed images**: You can use the slider to set the amount of processing power you want your computer to use to process your images. Pushing the slider to the left allows other applications to work simultaneously with DxO PhotoLab processing, but makes the processing slower. Pushing it to the right accelerates the processing but to the detriment of other programs.

**Sidecars**

- **Automatically export sidecars** [checkbox]: Settings files (or sidecars) are small text files associated with an image whose names include the extension”.dop”. They contain information for correcting images. If you want to transfer images to another computer using DxO PhotoLab, you can also transfer their sidecars settings. That way, when you add these images to your project (after checking that automatic loading is enabled on the other computer - see below), the corrections made on the original computer will show up on the destination computer. Note that you can also upload files to Settings via the File > Sidecars > Import menu.
- **Automatically import sidecars** [checkbox]: You can automatically include any existing sidecar information associated with image files that you download from another source.

**Cache**

**Maximum cache size**: Lets you set the size of the cache in order to improve overall performance. You can clear the cache by clicking on the adjacent Clear button.
## Keyboard shortcuts

### General

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>New project</td>
<td>Ctrl + N</td>
<td>Cmd + N</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl + X</td>
<td>Cmd + X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl + C</td>
<td>Cmd + C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
<td>Cmd + V</td>
</tr>
<tr>
<td>Select all</td>
<td>Ctrl + A</td>
<td>Cmd + A</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Shift + Z</td>
</tr>
<tr>
<td>Paste (text fields)</td>
<td>Ctrl + V</td>
<td>Cmd + V</td>
</tr>
<tr>
<td>Undock/Dock Image Browse</td>
<td>Ctrl + U</td>
<td>Cmd + U</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
<td>Cmd + ?</td>
</tr>
<tr>
<td>Go to Organize tab</td>
<td>Ctrl + F1</td>
<td>Alt + Cmd + 1</td>
</tr>
<tr>
<td>Go to Customize tab</td>
<td>Ctrl + F2</td>
<td>Alt + Cmd + 2</td>
</tr>
<tr>
<td>Switch between tabs</td>
<td>Ctrl + Tab</td>
<td>Ctrl + Tab</td>
</tr>
<tr>
<td>Open Preferences</td>
<td>Ctrl + Shift + P</td>
<td>Cmd + ,</td>
</tr>
<tr>
<td>Display reference image (hold down key)</td>
<td>Ctrl + D</td>
<td>D</td>
</tr>
<tr>
<td>Maximize interface</td>
<td>F11</td>
<td></td>
</tr>
<tr>
<td>Full screen mode</td>
<td>F12</td>
<td>Cmd + Shift + F</td>
</tr>
<tr>
<td>Display/Hide Image Browser</td>
<td>Ctrl + F9</td>
<td>Shift + Tab</td>
</tr>
<tr>
<td>Refresh Image Browser</td>
<td>F5</td>
<td></td>
</tr>
<tr>
<td>Rename folder/file/project/preset</td>
<td>F2</td>
<td></td>
</tr>
<tr>
<td>Adjust screen size</td>
<td>F3</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100 %</td>
<td>F4</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl + +</td>
<td>Cmd + +</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + -</td>
<td>Cmd + -</td>
</tr>
<tr>
<td>Temporary activation of Hand tool (hold down key)</td>
<td>Space bar</td>
<td>Space bar</td>
</tr>
<tr>
<td>Go to preceding image</td>
<td>Left arrow</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Go to next image</td>
<td>Right arrow</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Rotate image 90° to the left</td>
<td>Ctrl + L</td>
<td>Cmd + L</td>
</tr>
<tr>
<td>Rotate image 90° to the right</td>
<td>Ctrl + R</td>
<td>Cmd + R</td>
</tr>
<tr>
<td>Create a virtual copy</td>
<td>Ctrl + J</td>
<td>Cmd + D</td>
</tr>
<tr>
<td>Rank image (number of stars)</td>
<td>Ctrl + 0 to 5</td>
<td>0 - 5</td>
</tr>
<tr>
<td>Launch export of selected images</td>
<td>Ctrl + Alt + P</td>
<td>Cmd + K</td>
</tr>
<tr>
<td>Image properties</td>
<td>Ctrl + I</td>
<td></td>
</tr>
<tr>
<td>Remove image from project</td>
<td>Del</td>
<td>Cmd + Del</td>
</tr>
<tr>
<td>Delete image from disc</td>
<td>Del</td>
<td>Cmd + Del</td>
</tr>
<tr>
<td>Command</td>
<td>Windows</td>
<td>Mac</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------</td>
<td>-------</td>
</tr>
<tr>
<td>Delete virtual copy</td>
<td>Del</td>
<td>Cmd + Del</td>
</tr>
<tr>
<td>Print selected images</td>
<td>Ctrl + P</td>
<td>Cmd + P</td>
</tr>
</tbody>
</table>

**Organize tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display/Hide Source Browser</td>
<td>Ctrl + F10</td>
<td></td>
</tr>
<tr>
<td>Search folder</td>
<td>Ctrl + F</td>
<td></td>
</tr>
</tbody>
</table>

**Customize tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display reference image</td>
<td>Ctrl + D</td>
<td>D</td>
</tr>
<tr>
<td>Hand tool</td>
<td>Space bar</td>
<td>Space bar</td>
</tr>
<tr>
<td>Display reference and corrected images side-by-side or in front/ behind</td>
<td>Ctrl + T</td>
<td>C</td>
</tr>
<tr>
<td>Display reference and corrected images side-by-side or in front/ behind</td>
<td>F9</td>
<td>Tab</td>
</tr>
<tr>
<td>Fit to screen</td>
<td>F3</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>F4</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl + +</td>
<td>Cmd + -</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + -</td>
<td>Ctrl + =</td>
</tr>
<tr>
<td>Display/Hide grid</td>
<td>Ctrl + G</td>
<td>G</td>
</tr>
<tr>
<td>Display/Hide information overlay</td>
<td>Ctrl + H</td>
<td>I</td>
</tr>
<tr>
<td>Display clipped highlights</td>
<td>Ctrl + W</td>
<td>A</td>
</tr>
<tr>
<td>Display clipped shadows</td>
<td>Ctrl + B</td>
<td>B</td>
</tr>
<tr>
<td>Copy / Paste correction setting</td>
<td>Ctrl + Shift + C / V</td>
<td>Cmd + Shift + C / V</td>
</tr>
<tr>
<td>Create virtual copy</td>
<td>Ctrl + J</td>
<td>Cmd + D</td>
</tr>
</tbody>
</table>
## Full screen viewer

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXIF &amp; Navigator</td>
<td>i</td>
<td>i</td>
</tr>
<tr>
<td>Help &amp; Shortcuts</td>
<td>F1</td>
<td>Cmd + ?</td>
</tr>
<tr>
<td>Rating</td>
<td>Arrow Up/Down</td>
<td>Arrow Up/Down</td>
</tr>
<tr>
<td>Direct Rating</td>
<td>Ctrl + 0-5</td>
<td>0-5</td>
</tr>
<tr>
<td>Pick</td>
<td>7 or Ctrl + 7 or P</td>
<td>7 or Ctrl + 7 or P</td>
</tr>
<tr>
<td></td>
<td>Shift + Ctrl + 7 or Shift + P</td>
<td>Shift + Ctrl + 7 or Shift + P</td>
</tr>
<tr>
<td>Reject</td>
<td>9 or Ctrl + 9 or X</td>
<td>9 or Ctrl + 9 or X</td>
</tr>
<tr>
<td></td>
<td>Shift + Ctrl + 9 or Shift + X</td>
<td>Shift + Ctrl + 9 or Shift + X</td>
</tr>
<tr>
<td>Untag</td>
<td>8 or Ctrl + 8 or U</td>
<td>8 or Ctrl + 8 or U</td>
</tr>
<tr>
<td></td>
<td>Shift + Ctrl + 8 or Shift + U</td>
<td>Shift + Ctrl + 8 or Shift + U</td>
</tr>
<tr>
<td>Rotate left</td>
<td>Ctrl + L</td>
<td>Cmd + L</td>
</tr>
<tr>
<td>Rotate right</td>
<td>Ctrl + R</td>
<td>Cmd + R</td>
</tr>
<tr>
<td>Next</td>
<td>Right arrow</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Previous</td>
<td>Left arrow</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
<td>Cmd + Del</td>
</tr>
<tr>
<td>Zoom fit</td>
<td>F3</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100 %</td>
<td>F4</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Toggle zoom</td>
<td>Double click</td>
<td>Double click</td>
</tr>
<tr>
<td>Exit Full Screen</td>
<td>ESC</td>
<td>ESC</td>
</tr>
</tbody>
</table>
Registration, downloading, installation and activation

You need an Internet connection to follow the steps described below.

Registration

You must register your license in order to activate your software. To do so, go to the DxO Labs website at https://www.dxo.com/cd and follow the registration procedure. If you do not have a DxO customer account, please fill out the online form. If you already have a DxO customer account, please sign in.

Downloading

Once you have registered your license, you will find important information in your DxO Labs customer account about your software, along with the download link for DxO PhotoLab. This procedure ensures that you will be installing the latest version of the software. Depending on your equipment, click on the WIN or MAC button to begin downloading the installer.

After the download is completed, double-click on the program icon that you just downloaded, and follow the steps in the installation procedure.

Installation

Microsoft Windows

1. Choose the installation language.
2. A "welcome" dialogue window will confirm that DxO PhotoLab installation has begun. Click on Next.
3. After accepting the license conditions, click on Next.
4. Choose where you want to install DxO PhotoLab.
5. Click on Install. The installation will begin and will take a few minutes to complete.

OS X

1. As soon as downloading has completed, double-click on the DxO_PhotoLab_1_0.dmg icon to decompress it and to launch the installation.
2. A window will open in which you will need to drag and drop the DxO PhotoLab icon into the Applications folder. You can then launch DxO PhotoLab from this folder.
3. When DxO PhotoLab first opens, a window with an End-User License Agreement appears. To use DxO PhotoLab software, you have to read and accept this contract. Click on Accept to continue.

Once the application is installed, you can use it for 31 days without having to enter an activation code. DxO PhotoLab will work without restriction during this time period. Beyond 31 days, the output images are then marked with a watermark "DxO PhotoLab DEMO". If you have not done so already, we recommend that you purchase an activation code as soon as possible.

Printing is deactivated once the DxO PhotoLab trial period (31 days) has ended. To reactivate this function, you will need to register and activate your license.
Activation

1. Launch DxO PhotoLab.
2. A dialog box will appear. Enter (or cut and paste) your activation code in the appropriate field and click on the **Activate** button.
3. If you have not created your account, a message appears asking you to visit the page to create an account at the following link: www.dxo.com. Fill out the form and submit it. A message will tell you when your account has been created and your activation code will appear in your customer account. Return to the application and enter your activation code.
4. A message will inform you that DxO PhotoLab has been properly activated. Click on **OK**. You can now start using your software.

```
⚠️ The activation code lets you activate the software on 2 different computers (ESSENTIAL Edition) or on 3 different computers (ELITE Edition).
```

Uninstalling

**Microsoft Windows**

1. Click on **Start > Programs > DxO PhotoLab > Uninstall**.
2. Follow the procedure for uninstalling.

**OS X**

1. Go into the **Applications** folder.
2. Drag and drop the DxO PhotoLab icon into the trash can.
For best results with DxO PhotoLab, your computer must meet the following minimum specifications:

**Windows**
- Intel Core® 2 or AMD Athlon™ 64 X2 or higher (Intel Core® i5 or higher recommended)
- 4 GB of RAM (8 GB recommended)
- 4 GB or more of available hard-disk space
- Microsoft® Windows® 7 (64-bit) with Service Pack 1, Microsoft® Windows® 8.1 (64-bit), or Microsoft® Windows® 10 (64-bit)
- DirectX 9.0c-capable system
- OpenCl 1.2-capable graphic card with 1GB of video memory to handle OpenCL acceleration

**OS X**
- Intel Core™ i5 or higher
- 4 GB of RAM (6 GB recommended)
- 2 GB or more of available hard-disk space
- OS X 10.11 (El Capitan), 10.12 (macOS Sierra), 10.13 (macOS High Sierra)
- Graphics card with 512 MB of video memory to handle GPU acceleration

To process RAW images larger than 24 Mpix, 8 GB of RAM is strongly recommended. Further, a 4-core processor is also strongly recommended. Finally, starting with DxO PhotoLab, only 64-bit operating systems are supported.
Supported file formats

Files opened by DxO PhotoLab

DxO PhotoLab supports the following formats:

- RAW files from cameras supported by the software.
- DNG files from cameras supported by the software.
- DNG created by Adobe Lightroom, Camera Raw and DNG Converter, except for compressed DNG format with loss.
- 8- and 16-bit TIFF files
- JPEG files

Supported DxO ONE file formats:

- JPEG
- DNG
- SuperRAW

DNG files created in Adobe Lightroom, Camera Raw, or DNG Converter are supported so long as the original RAW files shot are compatible with DxO PhotoLab. In DxO PhotoLab, the DNG files created by Adobe software are treated as RAW files. Consequently, all of the tools and corrections described in this guide that are specific to RAW files apply to DNG files as well.

Files exported by DxO PhotoLab

DxO PhotoLab can export the following formats:

- 8- and 16-bit TIFF
- JPEG
- Linear DNG